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PART 1: ON1 HDR 2020 OVERVIEW

ON1 HDR 2020 is a full-featured photo editor designed to create rich, detailed high-dynamic-range (HDR) 
images from two to 13 bracketed photos. With HDR 2020, you can take multiple shots of a scene, at 
varying exposure levels—accurately capturing shadows, midtones and highlights in different frames across 
the series—and then blend them together to create a final image that has a much wider tonal range than a 
single shot could do. 

When using ON1 HDR 2020 as a standalone app, there are two primary components, one for the creation 
of an HDR image from a bracketed set of photos, and an editing module for finishing your photos. You can 
also use the batch-processing feature to create multiple HDR photos from a group of brackets taken at 
different times. To get started with a series of bracketed photos, see “Creating HDR Images” on page 10.

The Edit module has three tabs—Develop, Effects, and Local—each with a specific area of functionality: 
Develop for basic tonal editing, Effects for stylization, and Local for targeted editing of specific areas in 
your images. Information on using the Edit module starts on page 14.

The Edit module also supports a layered workflow, letting you create perfectly blended composites from 
multiple images. You can use the Layers feature to fine tune your HDR photos even further. For more on 
Layers, see page 69.

Once you’ve completed your finished HDR photos, you can print, export and share them directly from 
within ON1 HDR. See page 76 for complete information on these features.

ON1 HDR also works as a plug-in for Adobe Lightroom Classic, giving you full access to all of the tools 
found in the standalone app.
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Using the Help System
You can find and watch free video tutorials at the ON1 HDR 2020 Product Training site, available at ON1.
com. This is the best and quickest way to dig into the ON1 workflow and discover new techniques that will 
help you with your photo editing and organizing. There, you can search our Knowledge Base for frequently 
asked questions, common issues and more. 

The Help menu in ON1 HDR 2020 includes links to the training site, as well as our extensive library of 
video tutorials and more. 

System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.12 through 10.15; 
Windows 7, 8 or 10 releases, 
64-bit only

macOS 10.14 or 10.15; 
Windows 10 current releases, 
64-bit only

PROCESSOR Intel Core i5, Xeon or better 
processor

4-core Intel Core i5, Xeon or 
better processor

RAM 8 GB 16 GB

HARD DRIVE 1.5 GB for installation 1.5 GB for installation 
Fast (7200 RPM) or SSD drives

DISPLAY OpenGL 3.3 compatible video 
card with 512 MB video RAM, 
1280x720 resolution

OpenGL 4.2 compatible video 
card with 2 GB dedicated video 
RAM, 1920x1080 resolution

THIRD-PARTY APPS 
SUPPORTED (PLUG-IN)

Lightroom Classic 6 Lightroom Classic CC

OTHER Internet connection for 
activation and auto update 
checking.

Internet connection for 
activation and auto update 
checking; Wacom tablet for 
pressure-sensitive input; 
hardware display calibration tool

Installation
To install ON1 HDR 2020, double-click the installer icon and allow the installer to guide you. If you wish to 
use ON1 HDR as a plug-on for Adobe Lightroom Classic, make sure you close any open installations befor 
installing or updating.

MACOS

The application is installed in the ON1 HDR 2020 folder in the Applications folder. Plug-in files for 
Lightroom Classic found during the installation process will be installed automatically.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

https://www.on1.com/blog/category/product-training/
https://on1help.zendesk.com/hc/en-us
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WINDOWS

The application is installed in the ON1 HDR 2020 folder in the \Program Files\ON1\ directory. Plug-in files 
for Lightroom Classic will be installed automatically; if found, it will be noted in the summary displayed at 
the end of installation.

Support files are installed into \ProgramData\ON1\.

Launching ON1 HDR 2020
To launch HDR 2020 as a standalone app, with access to all modules, follow these steps:

MACOS

1.	 Open your Finder.

2.	 Navigate to the Applications folder.

3.	 Navigate to the ON1 HDR 2020 folder.

4.	 Double-click on the ON1 HDR 2020 application icon.

You can add ON1 HDR 2020 to your dock for easy access by clicking and holding the icon in the dock and 
selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS 7

1.	 Go to your Start Menu.

2.	 Select the ON1 group.

3.	 Select ON1 HDR 2020.

4.	 If you selected the “Add Icon to Desktop” option during installation you can also access ON1 
HDR 2020 from there.

WINDOWS 8.1 AND WINDOWS 10

1.	 Open the Start screen by pressing the Window key.

2.	 Select ON1 HDR 2020.

3.	 If you selected the “Add Icon to Desktop” option during installation you can also access ON1 
HDR 2020 from there.

NOTE: For information about running ON1 HDR 2020 as a plug-in to Adobe 
Lightroom, see page 6.
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Licensing and Registration
When you first launch ON1 HDR 2020, the upper left side of the main window will have two buttons, Buy 
Now and Sign-In. 

IF YOU HAVE PURCHASED ON1 HDR 2020:

Click on the “Sign-in” button and fill in your ON1 
account information (email and password) to register 
the app with us. (You should have set up an account 
when you purchased the software.) If the computer 
you are signing in with does not have access to the 
internet, you can manually register your software by 
clicking on the “No Internet connection” link in the 
license dialog.

Your license lets you install ON1 HDR 2020 on five 
computers. When you enter your ON1 account info, 
the app communicates with the ON1 activation server 
and registers your software for that computer.

If you wish to move your copy of HDR from one 
registered computer to a new one, and you are not going to be using the older machine, it is best to sign 
out of the old computer first. Open HDR and select Sign Out from the Help menu. This will deactivate HDR 
2020 on the current machine, and you can install and sign in on another machine.

You can log into your ON1 user account area (https://www.on1.com/login/) at any time to download the 
software, see the number of computers you have registered, and make basic changes to your account 
information, including your email address, password, and notifications.

If you have issues related to installing or activating HDR, please contact ON1 customer support, which can 
be reached by clicking on the ON1 website’s Support tab (https://on1help.zendesk.com).

TRIAL VERSION

ON1 HDR 2020 can also operate as a fully featured trial version for 30 days from when you first launch it. 
This gives you time to evaluate the product and see if it fits your needs. Each time you launch HDR during 
the trial period, the Buy Now button will tell you how many days remain in the trial.

You can purchase ON1 HDR 2020 at any time by clicking on the Buy Now button. Once you do that, click 
the Sign-In button the next time you launch the product and enter your ON1 account information. If your 
trial period has ended, HDR will present you with an activation window when you launch the app. There, 
you can enter your ON1 account info to activate the app.

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 

When you first launch ON1 HDR, sign in with your ON1 User ID (which 
you set up when you purchased the software) If you downloaded the 
app to try out, you can see how many days are left in your free trial.

https://www.on1.com/login/
https://on1help.zendesk.com
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information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 HDR 
2020. You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Uninstalling ON1 HDR 2020
To uninstall ON1 HDR 2020, follow these instructions:

First, deactivate your product: open ON1 HDR 2020 and select Sign Out… from the Help menu. (This will 
allow you to transfer your license to another computer.)

MACOS

1.	 Go to the Applications/ON1 HDR 2020/Documentation folder.

2.	 Double-click on the Remove ON1 HDR 2020 application.

WINDOWS

1.	 Go to Control Panels.

2.	 Under Programs select Uninstall a program.

3.	 In the list that comes up select ON1 HDR 2020 and then click on the Uninstall button.

Working with Files
ON1 HDR 2020 can view and open the following file types, in RGB color, at either 8 or 16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC)

•	 ON1 Photo format (ONPHOTO)
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When you are finished editing your photo in ON1 HDR, the app will save your merged image as a master 
.onphoto file, which you can use to re-edit it at any time. You will also be prompted to save your version in 
PSD, PSB, TIFF, JPEG, or PNG format.

Using ON1 HDR with Adobe® Lightroom® Classic
While it is designed to be a fully standalone app, ON1 HDR 2020 can also be accessed from within 
Lightroom Classic CC, providing an integrated, round-trip workflow for creating HDR images. 

To send a set of bracketed files to Lightroom for 
HDR processing, select two or more photos in 
Lightroom’s Library module, and choose Merge 
with HDR Standalone 2020 from the File > Plug-in 
Extras menu.

When you access ON1 HDR 2020 through the 
Plug-In Extras menu there are important file-handling options that are controlled in the Plug-ins tab of 
the HDR Preferences window. These need to be configured in advance, based on your desired workflow. 
Once these have been set, all images sent to HDR 2020 via the Plug-In Extras submenu will use these 
characteristics:

• File Type: The file type drop-down menu determines what type of file will be created. The 
default is PSD, which maintains layers. You can also select JPG or TIFF, if you prefer those 
formats.

• Color Space: The color space drop-down 
menu determines what RGB working 
color space is used; Adobe RGB 1998, 
sRGB or ProPhoto RGB.

• Bit Depth: The bit-depth drop-down 
menu determines the bit depth, either 8 
or 16 bits per pixel.

• Resolution: The resolution drop-down 
menu determines the resolution of the 
file.

NOTE: If you use ON1 HDR 2020 as a plug-in from Lightroom, we recommend 
using the Photoshop format (.PSD) as the exchange file format for maximum 
compatibility.

The Plug-In Extras submenu is found in Lightroom Classic’s File menu. 
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Extras
ON1 HDR 2020 supports a number of additional file types that can be used in the Edit module. These files 
are called Extras, and the file types include:

• Presets for use within the Edit module.

• Borders than can be imported and used in Layers.

• Textures that can be imported and used in Layers.

• Look-up tables (LUTs) for use with Effects’ LUTs filter.

ON1 includes a number of extras in the product when you install HDR, and you can create your own, or 
add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage your 
own extras, creating categories for each type, and deleting extras that you no longer want.

HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu, then follow these steps:

1.	 Select the type of extras you wish to import from the list of tabs at the top (Presets, 
Borders, Textures, LUTs) You can only import extras of one type at a time.

2.	 Click on the Import button in the footer of the left column. A dialog box will appear where 
you can select the files to import. If you want to import an entire folder, open the folder, 
select the first file, then shift-click on the last file. Click Import when your selection is 
complete.

The Extras Manager lets you import presets, textures, backgrounds, borders, and look-up tables (LUTs) for use with 
the different modules in ON1 HDR 2020.
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3.	 Select a category for your extras to live in. This is where you will be able to find it inside of 
the ON1 HDR 2020. You can select from an existing category or create a new one.

When your extras have been imported you will see them in the Extras Manager in the category you 
selected, in the type of extra they belong to.

Organizing Presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, HDR gives you the opportunity to add 
presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. To export a single preset, click on the preset from the list and click on the Export button.

What Type of Images Can I Import as Extras?

Backgrounds and textures may be any image file that HDR can open, including JPEG, TIFF, raw or 
Photoshop files. Border files must have a large central area that is transparent, so only files that support 
transparency, such as PNG, can be imported as borders. LUTs can be in either .3DL or .CUBE format.

NOTE: If you download an .ONPreset or .ONP file (for use with Develop or 
Effects), you can simply double-click on it to install it. For more information, see 
the Presets section of this guide, starting on page 35.

USING EXTRAS WITH LAYERS IN THE EDIT MODULE

You can view and add extras to any open document in the Edit module by adding a new layer. Just click 
Layer > Add Layer from the File menu to open up a file browser window on-screen, where you can choose 
installed extras or any file from your computer. For more on this, see page 69. 

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
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categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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PART 2: CREATING HDR IMAGES
When you first launch ON1 HDR 2020, the main window will have two buttons in the center of the screen: 
Open Photos, which lets you open a set of bracketed photos for processing, and Batch Process, which you 
can use to perform an HDR operation on a folder full of bracketed image sets.

NOTE: Once you have created HDR photos with ON1 HDR, the bottom of the 
main startup screen will display a filmstrip of your most recently generated 
images; double-clicking on one of those files will open the image in HDR’s Edit 
module.

Creating a Single HDR photo
If you wish to create a single HDR photo from a bracketed series of files, click on the Open Photos button. 
Locate the set of images and select all of the items you wish to merge. To select a group of contiguous 
photos (ones next to each other in order), click on the first one you wish to select, then hold down the Shift 
key and click on the last photo. If you want to add noncontiguous photos (ones not next to each other), click 
on the first photo, then use the Command (Mac) or Control (Windows) key and click on each photo you 
wish to compare. When you have your selected photos, choose Open. 

Once you’ve selected your bracketed set, the Create HDR window will open, giving you a simple set of 
controls for building your final HDR images.
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The Create HDR window has the following options:

A.	The Preview window displays a rendition of your merged HDR image (and is resizable).

B.	 The Options bar has settings for adjusting ghosting, choosing a default look, and which 
module you wish the resultant image to open in.

C.	 The Reference panel includes the images used to build the HDR, with their exposure values 
relative to the base image. The image with the outline is the base version used for deghosting; 
the base image for exposure is represented by the lens aperture icon next to the checkmark.

D.	Save/Cancel buttons.

Once the Create HDR window is open, you can use the various options to tune your image. You can adjust 
the base image: clicking on the different frames in the Reference panel will choose a different base image 
for deghosting; to select a different base 
exposure image, click on the small lens aperture 
icon in a different image of the series. (By 
default, HDR chooses the image it felt was 
closest to the middle of the series for both 
exposure and deghosting.)

The Default Look options are also designed to 
help get you started, corresponding to style 
options in the Tone and HDR Look panes in the 
Edit module. Natural and Surreal use those 
styles from the HDR Look pane, and the Natural 

The four options in the Options Bar’s Default Look popup correspond to 
settings found in the Tone and HDR Look panes in the Edit module. Once 
you’ve built your HDR file, you can go into the Edit module and edit any of the 
settings, add other filters and more.
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Auto and Surreal Auto options also add the Auto Tone option from the Tone & Color pane. They are only 
designed to be a starting point: You can override any of the options by adjusting the settings in the two 
editing panes.

The deghosting section of the Options 
bar has options to blend portions of 
the frame that might have shifted 
during the image series (things such 
as clouds, flowing water or moving 
branches). Depending upon the 
amount of ghosting, you can choose 
from four levels of deghosting (or 
none). If you wish to see those areas in 
your image that will need deghosting 
applied to them, click the Show 
Ghosting button. Those areas that 
have ghosting issues will be shown 
with a red overlay. Depending upon 
how much movement there was in 
your scene, you can then choose the 
appropriate level of deghosting, or, in 
some instances, cancel and choose a 
different set of images to blend into an HDR.

The Align button in the Options bar is on by default, which means that, during the HDR generation process, 
HDR will attempt to automatically align the images, based on their contents. Turn the Align button off 
when the alignment process results in a bad composite, or when you don’t want HDR to align the images 
(when working with star photography, for example). With the Align feature off, HDR will use the selected 
base image for the HDR process.

Once you have your settings adjusted to the way you’d like them, you can click Save and ON1 HDR will 
build your HDR, saving it in the .onphoto file format (in the same folder as the original bracketed files) and 
opening it in the Edit module. 

NOTE: The .onphoto format is proprietary to ON1, and saves your edits as you 
work, which means you can re-edit your HDR at a later time, and export a new 
file with your changes. If you decide that you wish to use a different HDR Look 
style, or want to add additional effects to your photo, open the .onphoto file in 
HDR and your previous edits will be present.

Using the Batch Processor to Build Multiple HDRs
The Batch Process option in ON1 HDR 2020 lets you take a folder containing multiple sets of bracketed 
shots from a shoot, and automatically turn them into HDR photos ready for editing. The process creates 
separate .onphoto files that can be opened directly in ON1 HDR via the Open Photos option.

With the Show Ghosting option turned on, areas that have ghosting issues will be shown with 
a red overlay.
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To set up your shoot for batch processing, create a master folder, with subfolders that contain each 
individual bracket set inside them. Then, click the Batch Process button and select your master folder 
and choose Open. ON1 HDR will go through the subfolders, building each bracketed set using the default 
settings for the Create HDR window, and saving the merged HDR image as an .onphoto file in each 
subfolder.

After the batch operation is complete, you can open any of the merged HDRs via the Open Photos button 
in ON1 HDR, or by double-clicking the .onphoto file in Windows Explorer or the MacOS Finder. The photo 
will open in the Edit module, ready for further editing.

To set up your brackets for batch processing in ON1 HDR, create a master folder, then add 
subfolders to it, creating each subfolder as an individual set of bracketed photos, as shown in the 
MacOS screenshot on the left side, above. When you run the Batch Process option, the app will go 
through each folder, and create an .onphoto file with the default Create HDR settings (see the 
screenshot above right). Double-clicking on the .onphoto file will open it in the Edit module, where 
you can further to refine or stylize your photo.
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PART 3: EDIT MODULE BASICS
ON1 HDR 2020’s photo-editing power is found in the Edit module, which consists of three distinct editing 
functions, separated into tabs:

• Develop is where you perform basic, global editing operations—adjusting tone and color, 
removing noise, sharpening and more. 

• Effects is the stylization center of HDR, with nine filters—offering such operations as black 
and white conversion, HDR stylizing, dynamic contrast, glows, sharpening, curves and more— 
that can be stacked in any order, all with extensive blending and masking options. 

• Local Adjustments are designed to apply targeted edits to parts of your photos, letting you 
perform traditional photo-editing tasks—like dodging and burning—with ease.

Switching between the different tabs in the Edit module is as simple as clicking on the appropriate tab. 
While you work on an image, all of your settings in each tab are saved while you edit. 

HDR 2020’s Edit module also includes a Layers pane, which lets you stack multiple images together to 
achieve sophisticated composites that aren’t available in many standalone photo editors. 

When using HDR as a plug-in from Lightroom Classic, you can still move from tab to tab in the Edit module 
(and use the Layers functionality), but your photos will not be re-editable once you leave HDR. 

To help you save time and create the looks that you love best, ON1 HDR 2020 also includes a robust preset 
system that lets you save settings made in any of the editing tabs—including local adjustments and masks—
for applying to other photos. Editing presets can be applied in the Edit module, and in Browse, and, like all 
other elements of HDR 2020, are re-editable. (Presets are discussed in detail starting on page 35.)
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ON1 HDR Edit Module Overview
Edit provides you with an easy-to-use workspace for editing your photos. Below is an overview of the main 
window sections of the Edit module:

A.	Tool Well: Tools for working within the Edit module.

B.	 Preferences/Help: Shortcuts to app preferences and help; bottom icon opens and closes the 
Presets/Filters panel.

C.	 Preset panel: List of all installed presets (by category). When working in the Effects tab, a 
Filters panel is visible as well. 

D.	Search: Searches presets (and filters, when working in Effects) by name.

E.	 Preview Window: Displays the current photo in detail view.

F.	 Preview option toggles: Magnification slider for current image, compare (before/after) mode, 
show/hide mask, turn soft proofing and preview on or off.

G.	Tool Options bar: Options and settings for currently selected tool.

H.	Photo Information pane: Navigator, levels (histogram) and general photo information.

I.	 Layers pane: Add, edit and manage layers here.

J.	 Edit tabs: Tabs for accessing Develop, Effects and Local Adjustments. Clicking on a tab brings 
up the settings for that tab.

K.	 Reset bar: Reset all (all Edit module settings), Reset (resets the current tab’s settings), Sync 
settings with previously edited photo (when in Filmstrip view)
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L.	 Output: Shortcuts for printing, exporting and sharing the current photo. (Bottom icon opens 
and closes the right panel.

The left side of the window contains a Tool Well and a Presets pane (when using the Effects tab, you will 
also see a Filters tab alongside Presets).

The right side of the screen contains some photo informational panes at the top—Navigator, Levels/
Histogram, Info and a History pane—the Layers panel, and tabs for the three editing areas inside Edit: 
Develop, Effects, and Local. Clicking on a tab will bring up the options and settings for that area.  

ON1 HDR provides several ways to navigate and view your image in the Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

Navigator, Levels, Info and History Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info and 
History panes. These tools can be useful for inspecting and viewing details of your image, as well as for 
looking at all of the Edit module adjustments made during a session.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white square 
region marks the image area that is visible in the preview pane. You 
can pan your image by clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom buttons 
representing percentage zoom views (100%, 50% and 25%). Click 
on one of the buttons to change the view. Fit zooms to fit the 
current canvas size, while 100 zooms to 100%, displaying the 
actual pixels.



ON1 HDR 2020 User Guide	 Part 3: Edit Module Basics	 17

THE LEVELS PANE

This gives you a color chart of the shadow, midtone and highlight 
areas based on the image RGB values (commonly known as a 
histogram). This is useful to show areas within the image that may 
be clipping. Clipping is when your image contains pure blacks or 
white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the 
right represents the highlights. At the top of each end is a triangle. 
If the triangle is lit, there is clipping on that side of the histogram. 
If you click on the arrows, you will activate the clipping overlay 
on your image, which displays the areas that are clipped. Those 
areas with a blue overlay are pure black, while the areas with the red overlay are pure white. You can turn 
the clipping view off again by clicking on one of the triangles. You can also temporarily enable clipping 
view by holding down the J key at any time. The clipping view is useful when you are making adjusts to the 
brightness and contrast of your image. (See page 43 for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in an 
easy-to-read format. This metadata includes camera make and 
model; lens focal length; capture date and time; file type; GPS 
location data; ISO setting; shutter speed; aperture; and exposure 
compensation.

The Info pane also displays file-specific date, including name, color 
space, image dimensions and resolution. If any of the metadata 
fields are unavailable they will be left blank.

Settings Applied

At the bottom of the Info pane is a section that shows all of the 
operations from the Edit module that have been applied to the 
current image. Clicking on the right arrow to the left of the label 
will display a list of every tab in the Edit module, as well as primary adjustment options, including cropping, 
retouching and text operations. If an image has had any adjustments made to it, that section of the Settings 
Applied area will be represented in white type, and you can use the arrows to the left of the label to drill 
down further into the Develop, Effects and Local Adjustment tabs to see which adjustments were made to 
an image. (On an image that has had no adjustments, all of the settings will be grayed out.)

Double-clicking on any of the available items inside the Settings Applied area will take you to that specific 
setting inside the Edit module, where you can make any desired changes.

GPS Metadata

If your image has GPS metadata embedded in it, the GPS button will appear in the Info pane. Clicking on 
this button will open your default web browser to Google Maps to the location where the image was taken.



ON1 HDR 2020 User Guide	 Part 3: Edit Module Basics	 18

THE HISTORY PANE

ON1 HDR 2020 has a robust Undo capability, which is helpful 
when you wish to back up a few steps during the editing process. 
When you want to go back further, it can be tedious to keep 
pressing Command/Control-Z. That’s where the history pane can 
be extremely useful. It displays every adjustment made during an 
editing session. From the History pane, you can scroll through your 
edits, all the way back to the state of your photo when you opened 
it for editing.

As you work, the History pane tracks all of your edits—even when 
working with layered files—adding each change you make to the 
top of the pane. History displays not only the adjustment, but in many cases will display the settings of 
sliders in the various panes and filters. 

You can scroll through the list, and, if you click on an item, HDR will “roll back” your edits to the spot you 
clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire Edit 
history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that point 
on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo.  

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.
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The Tool Well
The Edit module has 14 tools available for you when you are working on a photo, and are accessible via the 
Tool well on the left side of the screen. Some tools—Transform (Move), Crop, and View—are self-contained 
within the tool icons. Others are nested within a tool group—Local, Mask, Refine, and Fix—and are 
accessible via the Tool Options bar at the top of the screen when you click on one of those tool icons:

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Transform (Move) Tool: Moves and changes the size and rotation of your layer. 
Shortcut key: V

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut  
key: K

• Adjustable Gradient (Local group): Applies a selective gradient in local 
adjustment mode. Shortcut key: Shift+K

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes Perfect 
Brush option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask in any filter (or 
to the entire stack). Shortcut key: M

• AI Quick Mask Tool (Mask group): Create high-quality masks with only a few 
strokes as guidance. Shortcut key: W

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to help 
mask difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut 
key: Shift-K

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend more 
naturally. Shortcut key: L

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines.  
Shortcut key: Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. 
(Includes Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from a sample of another area. Shortcut key: 
Shift-S

• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z

To access a tool, simply click on the tool, or use the shortcut key attached to the tool. When selected, the 
cursor will change, and you will see a set of options for the tool in the Tool Options bar above the Preview 
window. If the selected tool is part of a tool group, you will see the other tools in that group, on the left 
side of the Tool Options bar.
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CROP TOOL

This tool lets you crop your image, 
and is fully non-destructive when 
you are using ON1 HDR 2020 as a 
standalone app.

To crop an image, select the Crop tool from the 
Tool well. Select any preset crop ratio you would 
like to use from the Options bar; the default 
is Freeform, which lets you crop in whatever 
size or ratio you would like. Adjust the corner 
handles of the crop tool overlay to get the 
area you wish. (The area outside the crop box 
appears darkened for guidance.) You can resize 
and move the image inside the crop box. When 
you are satisfied with your settings, press the 
Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply 
click and drag inside the box. You can also 
nudge the image using the arrow keys on your 
keyboard. To resize the crop box, click and drag on any of the handles. Clicking on a corner handle allows 
you to adjust two sides at the same time; clicking on a side handle allows you to adjust that side. If you hold 
the Shift key down while adjusting the size, the box’s proportions are maintained. To rotate the crop box, 
move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

Crop Tool Options Bar:

• Preset pop-up: Lets you choose from Freeform or constrained preset ratios

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Reset: Resets the crop area to the size of your original photo.

• Apply: Applies the crop.

The Crop interface, with the Crop Preset pop-up open.
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TRANSFORM (MOVE) TOOL

The Transform tool is used to manipulate the contents of a layer, and works even if the only 
layer you have is the base photo layer. A layer may be repositioned, sized or rotated using 
the Transform Tool. When the tool is selected, handles will appear on the edges of the 
selected layer. You use these handles to manipulate the image. When you are done, click the 

Apply button in the Tool Options bar.

The Transform tool is layer-dependent, and each document layer can have its own transform operations. It 
is useful when compositing photos, or applying backgrounds and textures in a multi-layered file.

Repositioning a Layer

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction.

Resizing a Layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center.

You can type in the size you desire in the Tool Options bar (see below) in the width and height fields. You 
can also size a layer to fill the canvas automatically by pressing the Fill button in the Options Bar.

Rotating a Layer

To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use the opt (alt) left 
and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer quickly in 90 
degree increments, you can use the rotate left and rotate right buttons in the Tool Options bar.

Flipping a Layer

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options bar.

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options bar or by pressing the Escape key.

Restoring a Layer After a Move

The Reset All command inside the Edit module will not reset transforms made with the Move tool. To reset 
your layer to its original, non-transformed state, click the Move tool and adjust any rotation you might have 
made, as well as any flip operations. Then choose the Fit to Canvas button. 
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Transform Tool Options Bar

• Width: Changes the width of the layer, in pixels.

• Height: Changes the height of the layer, in pixels.

• Scale: Proportionally scales the layer, in percentage.

• Rotation: Rotates the layer, by degrees.

• Rotate Left/Right buttons: Rotates the layer 90° clockwise or counterclockwise.

• Flip Horizontal/Vertical buttons: Flips the horizontal or vertical axis.

• Fill Canvas button: Scales the layer contents to fit the document size. 

ADJUSTMENT BRUSH (LOCAL GROUP)

The Adjustment Brush, which works within the Local Adjustments tab, works like a standard 
brush tool, with adjustable sizes, feathering and opacity. You can paint an adjustment in or 
out via the Mode pop-up in the Tool Options bar, and adjust the size and feathering of the 
brush via the bar or with the bracket keys on your keyboard. The Adjustment Brush is 

especially powerful when used with the Perfect Brush option, represented by its icon at the right of the 
Tool Options bar.

The Perfect Brush option incorporates a color-based, self-masking 
technology to help create precise selections and masks. When you 
turn the Perfect Brush option on, the Adjustment Brush collects 
the colors under the center of the brush and applies the effect 
only to those colors. This protects the adjustment from being 
applied across edges. A great of example of using the Perfect 
Brush would be if you wanted to darken the sky in an image, but 
didn’t want to darken a group of mountains on the horizon.

The Threshold slider will allow you to control the balance between 
keep and drop colors, based on the area you are working on. For 
example you may want the Perfect Brush to be very precise and 
only paint away very similar colors, other times you want it to paint away a broad range of colors in the 
same neighborhood.

The Transition slider controls the feather of the Perfect Brush based on color. To create a soft edge, 
increase the transition. To create a harder edge you need to decrease the transition.

TIP: You can turn the Perfect Brush on and off using the Command-R keyboard 
shortcut (Control-R on Windows). You can also temporarily lock the color to 
remove by holding down the Control key (Windows) or the Command key 
(Mac). This is useful when brushing through areas with a lot of openings like 
tree branches.

Perfect Brush options.
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Adjustment Brush Tool Options

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in ON1 HDR 2020’s Preferences 
window).

• Use your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys 
on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press the Option (Mac) or Alt (Windows) key on your keyboard and press one of the 
number keys. Each number represents an opacity percentage from 10% (1) to 90% (9); 
0 represents no opacity.

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.
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• Perfect Brush: The Perfect Brush option incorporates a color-based, self-masking technology 
to help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Tool Options bar—the Masking Brush collects the colors under the 
center of the brush and applies the effect only to those colors. This protects the adjustment 
from being applied across edges, such as tree branches. 
Further settings for the Perfect Brush can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options:

• Color Threshold: This option lets you control the balance between keep and drop 
colors, based on the area you are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar colors, while at other times 
you want it to paint away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To 
create a soft edge, increase the transition. To create a harder edge, decrease the 
transition amount.

Wacom Support

ON1 Photo supports pressure-sensitive tablets from Wacom with the Adjustment Brush. When you use 
the Masking Brush you can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You can activate 
pressure sensitivity for both size and opacity by clicking the appropriate buttons in the drop-down menu.

Detailed information on using Local Adjustments in ON1 HDR 2020 starts on page 65.

ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Gradient Adjustment tool is very similar to the Masking Bug, but it is solely for use 
within the Local Adjustments tab. It lets you create a linear or radial gradient mask across 
part of your image, The gradient mask goes from dark to light in tone, applying more of the 
adjustment where the gradient is lighter, and less of the adjustment where the gradient’s 

tone is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the 
brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the Gradient Adjustment 
tool (top down, bottom up, left and right, and circular vignettes), and changes the current bug 
(if there is one) to match the preset.
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• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.

• Opacity: Sets the maximum opacity or density of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating Gradient Masks

Once you’ve added a gradient to an image, you can modify it by 
accessing the parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of the 
gradient and drag.

• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (hardness) of the mask, click and drag 
along the dashed line.

• To rotate the mask, click the smaller circle near the gradient 
center and drag.

Detailed information on using Local Adjustments in ON1 HDR 2020 
starts on page 65.

MASKING BRUSH (MASK GROUP)

The Masking Brush is one of two tools used for masking filters in Effects, as well as 
layer masks. When you select the Masking Brush, your cursor changes to look like two 
concentric circles, one representing the inner hard edge of the brush, and soft outer, 
feathered edge of the brush. At the center of the brush is either a plus or minus. The plus 
means that you are painting “in” a filter’s effect, while minus means the brush mode is set 

to paint out.

Masking Brush Tool Options

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the option (alt) key temporarily.

The Edges gradient shape lets you create 
such masking effects as customized, 
adjustable vignettes.
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NOTE: If you would like to invert the mask (turn it from black to white), in 
order to paint a filter’s effect into your image, select the Masking Brush tool, 
then choose Invert Mask from the Mask menu.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in ON1 HDR’s Preferences).

• Use your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering (hardness) of the brush by using the Feather 
pop-up in the Options bar. Use a small feather at high magnification for precise, hard-edged 
work and a large, soft-edged brush in Fit-screen mode for general work. You can see your 
feather by viewing the outer concentric circle of the brush. Adjust the size of the feather by 
holding down the Shift key and pressing the right or left bracket keys on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press the Option (MacOS) or Alt (Windows) key and press one of the number keys. 
Each number represents an opacity percentage from 10% to 90%; 0 is no opacity.

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your mask. 
While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Perfect Brush: The Perfect Brush option incorporates 
a color-based, self-masking technology to help create 
precise selections and masks. When you turn the 
Perfect Brush option on—by clicking on the Perfect 
Brush icon in the Tool Options bar—the Masking Brush 
collects the colors under the center of the brush and 
applies the effect only to those colors. This protects 
the adjustment from being applied across edges, such 
as tree branches. Further settings for the Perfect Brush 
can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options: Perfect Brush options.
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• Color Threshold: This option lets you control the balance between keep and drop 
colors, based on the area you are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar colors, while at other times 
you want it to paint away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To 
create a soft edge, increase the transition. To create a harder edge, decrease the 
transition amount.

TIP: You can turn the Perfect Brush on and off using the Command–R (MacOS) 
or Control-R (Windows) keyboard shortcut. You can also temporarily lock the 
color to remove by holding down the Command (Mac) or Control (Windows) 
key. This can be useful when brushing through areas with a lot of openings like 
tree branches.

Wacom Support

ON1 Photo supports pressure-sensitive tablets from Wacom with the Masking Brush. When you use 
the Masking Brush you can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You can activate 
pressure sensitivity for both sizer and opacity by clicking the appropriate buttons in the drop-down menu.

MASKING BUG (MASK GROUP)

The Masking Bug is used for blending layers by creating radial, gradient and reflected 
gradient mask shapes quickly. It works in a similar manner to the Adjustable Gradient tool 
in the Local Adjustments pane. The mask goes from dark to light in tone, applying more of 
the adjustment where the gradient is lighter, and less of the adjustment where the gradient’s 

tone is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the 
brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a filter, click on the Masking Bug in the Tool well, then click in the image 
roughly where you wish the gradient to go. You’ll see 
the outline of the gradient, which is called a bug. You 
can use the handles on the bug to move your gradient 
around, increase or decrease the length of the gradient, 
or rotate it.

You can change the gradient shape via the Tool Options 
bar: in addition to the standard dark-to-light horizontal 
gradient, you can also create a circular gradient and a 
reflected gradient, which is like the horizontal gradient, 
but goes from black (no effect) at the outer edges to 
white (full effect) in the center.

In this image, a Dynamic Contrast filter has been applied in Effects. 
To keep the effect out of the clouds, a Masking Bug has been added.
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Masking Bug Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the tool (linear top down, 
linear bottom up, left and right, and circular vignettes), and changes the current bug (if there 
is one) to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.

• Opacity: Sets the maximum opacity or density of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a Gradient Mask

Once you’ve added a gradient to an image, you can modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle at 
the center of the gradient and drag.

• To resize a radial gradient, click and drag on the 
solid line.

• To adjust the feather (or hardness) of the mask, 
click and drag along the dashed line.

• To rotate the mask, click on the smaller circle 
near the center of the gradient and drag.

TIP: To see the mask created by the Masking Bug, and the range of black to 
white tonality, choose Show Mask from the View menu. You can choose either 
a red overlay, which presents the mask over your image, or grayscale, which just 
shows the mask as black to white tones.

Working with Multiple Masking Bugs

You can have up to six Masking Bugs per layer. To add another Masking Bug, press the Add button or click 
outside of the current bug while the Masking Bug tool is selected.

Only one Masking Bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.
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Masking Bugs are subtractive. Each bug hides more and more of the current layer. When Masking Bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint areas back in hidden by the Masking Bugs.

AI QUICK MASK TOOL (MASK GROUP)

Powered by machine learning, the new AI Quick 
Mask tool can create high-quality masks with just a 
few strokes as guidance. To use it, just mark areas 
you want to keep in green and areas you want to 

drop in red. Then using its artificial intelligence it analyses the 
color, tone and texture of the marked regions to learn what you 
want to make out and then automatically finds the edges and 
creates the mask for you. Use it with layers to replace skies or with 
filters to selectively apply them quickly. 

Here are the steps you need to follow to use the AI Quick Mask Tool:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

2.	 Now press the Apply button in either the Tool Options bar or the AI Quick Mask HUD. This 
will generate a temporary mask to preview the results. Areas that are filled with red will 
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the AI 

When you first open the AI Quick Mask tool, you’ll 
see  a window—called the HUD—that includes 
instructions for using the tool.
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Quick Mask HUD. If there are areas that are incorrect, you can continue to improve the 
results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and ON1 
HDR switches to the Refine Mask tool, which you can use over difficult, semi-transparent 
areas—like tree branches—if necessary.

NOTE: The AI Quick Mask tool resets any existing mask on a layer or filter.

AI Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked. In your layer these areas will become transparent. 
On a filter in Effects, these areas will have the filter’s effect removed.  
	 You can tell your current mode by looking at the plus or minus icon in the center of the AI 
Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is a plus, 
you are painting keep (green) areas. You can change the mode in the Tool Options bar, or by 
pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways: 

• Use the Size pop-up in the Tool Options bar. 

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ . 

• Use your mouse’s scroll wheel (this option can be set in HDR’s Preferences). 

• Use your Wacom pressure-sensitive tablet. 
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Further settings for the AI Quick Mask tool can be found by clicking on the gear icon in the Tool Options 
bar. There, you can set the following options (shown right): 

• Pressure Adjusts Size: This option lets you control 
the size of the brush using a pressure sensitive tablet. 
The harder you press, the larger the brush becomes 
up to the current setting of the size slider.  

• Refine Edge: This applies the Refine Mask Brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This is on by 
default and recommend for most photos.

• Show HUD: This displays the AI Quick Mask HUD 
dialog (shown on page 29), which provides 
guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green mask overlays on top of your image. A 
setting of 100 displays only the mask; the default setting is 50.

REFINE BRUSH (REFINE GROUP)

This tool cleans up intricate areas and the borders along a mask, and is helpful for cleaning 
up a mask created with the Masking Brush. For example, when you wish to apply an effect to 
a subject, and there are areas such as hair, or tree branches that are difficult to remove with 
the Masking Brush.

To use the Refine Brush, select the tool in the Options bar and paint along the edges where you would like 
the mask to be refined. The brush strokes are displayed as a red overlay, and when you let up off the mouse 
button, HDR will work to make making the mask edge more defined, improving the overall mask.

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which always refines to remove from 
the mask, Paint In, which always refines to add to the mask, or Auto, which does both at the 
same time. Paint Out is recommended in most cases.

• Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results.

• Pressure Adjusts Size (gear icon): If you have a Wacom tablet you can control the size of the 
brush with pressure when this setting is turned on.

CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or 
halos along the hard edges of a mask; just click and drag along the edges of a mask you wish 
to refine. Fringes are common when the background to be removed is brighter than the 
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foreground. The chisel works like a chisel or plane in a wood shop: It removes just a sliver along the edges, 
and, because it only works on the edges, you don’t have to be too careful when using it.

Chisel Mask Tool Options

• Mode: Select remove or add

• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool icon to apply the chisel to the entire mask.

BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool softens edges of the mask where you paint; all you need to do is run the 
tool over the edges you wish to blur. Softening the edges on blurred or semi-transparent 
subjects like hair can make them blend with a new background in a more realistic manner. 

Blur Mask Tool Options
• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 

and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the tool size. Use a large size to make brushing fast; size doesn’t affect blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur tool icon applies the blur to the entire mask.

PERFECT ERASER (FIX GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your 
image. It uses a content-aware algorithm that replaces the pixels with a natural-looking result 
within the boundaries that are painted.

Using the tool is easy: paint over the area you wish to remove and release the mouse, making sure you 
cover the entire area. A red overlay appears where you paint. If the first attempt does not give you a 
perfect result, paint over it again. You can also fine tune the area after applying the tool by using the 
Retouch Brush (see below).
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Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of two options; brush size, and Wacom tablet support The 
default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking on 
the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. The 
maximum brush size is 500 pixels. If you have a Wacom pressure-sensitive tablet, select the Pressure 
Adjusts Size button in the Options bar.

RETOUCH BRUSH (FIX GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab 
the brush on areas that contain spots or other imperfections, such as acne, sensor dust, 
power lines and more. The tool looks at the neighboring areas in your image and fills in the 
brushed area with an area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: Click on the button to activate the Wacom sensitivity controls.

CLONE STAMP (FIX GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. 
Hold down Option (Mac) or Alt (Windows) and click the area you want to clone from. 
Then click and drag on the area you want to clone over and it will clone from the point you 
selected.

Clone Stamp Tool Options:

• Brush Size: This adjusts the overall size of the brush.
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• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click the button to activate.

VIEW (ZOOM) TOOL

This tool, which is the default tool selected when you open an image in the Edit module, 
adjusts the magnification of the image in the Preview window. With the Zoom tool selected, 

click in the Preview window to zoom in and center the image at the location clicked. 
Hold down the Option/Alt key to display the Hand tool, which lets you pan around the 

magnified image. You can also double-click the Zoom tool in the Tool well to set the image to 1:1 (or 100%) 
magnification view, which shows every pixel. This is best when examining small details.
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Presets
Presets are stored “recipes” that include sets of Edit module adjustments, and can be applied to one or 100 
images with ease, in Browse or Edit. Presets are a fast way to get consistent results when editing a group of 
images, helping you hone your own look. You can also easily create your own presets.

ON1 HDR 2020 comes with more than 50 built-in presets, in seven categories, ranging from landscapes to 
black and white and much more. You can create your own presets, or import presets from other ON1 users 
and photographers.

You can create presets that apply Develop adjustments, Effects settings, and local adjustments that use the 
Adjustable Gradient tool, and any combination of these.

Presets can also store crop settings and retouching information, as well as masks created with brush tools, 
Effects’ Masking Bug, and the Adjustable Gradient Tool in the Local Adjustments panel. If you apply a 
preset that contains these options, you should check to make sure that you have the desired result; if not, 
you can reset the various individual operations via the Settings menu. 

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of 
presets. (The view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various 
presets, with a thumbnail of the current image with the preset applied. From there, you can apply a preset to the current image.

As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name.(Hot Desert is shown above in the 
preset category list.) Clicking on that icon will open a full-screen window showing your photo with that category’s presets applied to it. (See 
the following page for a screen shot of the Quick View Browser.

HDR lets you create your own custom presets and categories, and you can also create subcategories of presets. (See page 7 for more.)
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APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1—ordered by category—as well as any presets you might have created or installed yourself. Clicking on 
a category name will open it and display any presets within that category, with a tiny thumbnail showing 
your selected image with that preset applied to it. To change the 
size of the thumbnails in the Presets panel, select the Browser 
Mode option from the View menu and choose One, Two or Three 
Column View.

If you’d like to see a larger representation of what your selected photo will look like with a category’s 
presets, click on the Quick View Browser icon in the category’s title bar. That will display a window with all 
of the presets in that category. (Press the Escape key to close the Quick View Browser.)

To apply a preset to a photo, click on the preset in the mini-browser or in the Quick View Browser. Presets 
are not cumulative; clicking on another preset will remove the previous one and apply the new one.

Once you’ve applied a preset, you can reduce its overall effect by hovering 
over the chosen preset. There, you will see a Fade slider, where you can lower 
the opacity of any Effects filters applied with the preset. (Develop and local 
adjustments included in a preset are not reduced.)

After you have applied a preset, you can still make changes to any of the settings—
in Develop, Effects, and Local Adjustments—add or remove adjustments, switch to 
another preset, perform any retouching or more. 

If you don’t like a preset, clicking on another one will replace the settings of the 
previous preset with the settings of the new preset. To remove a preset entirely, 

A preset with the Quick View Browser icon shown.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from the Window menu) will open a 
full-screen representation of that category’s presets, giving you a larger representation of how that preset will look on your image.

The Fade slider reduces the 
opacity of Effects filters 
applied with a preset. To 
find it, just hover over the 
applied preset in the 
Presets pane.
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choose one of the reset options from the Settings menu, or remove the individual settings from the 
appropriate panes in Develop and Effects. (The latter approach is recommended if you have created masks 
or local adjustments that you wish to preserve.)

You can save a preset as a favorite by hovering over its thumbnail in the browser, and clicking on the 
heart icon. This will add that preset to a Favorites category that resides at the top of the Presets panel. To 
remove a favorite, click again on the heart icon.

Inserting Presets (Effects tab only)

When you click on a preset, HDR’s default behavior is to remove any 
existing adjustments and apply the newly chosen preset to your photo. 
Sometimes, however, you would like to add a preset on top of your 
adjustments. To do this, open the Presets pane, right-click on the preset 
you wish to add, and choose Insert Preset from the pop-up menu. This will 
add the preset’s filters above the currently selected filter pane  and will 
preserve any edits you made in the Develop or Local Adjustment tabs. 

Inserting a preset will only add that preset’s Effects filters to your currently edited photo. Develop 
adjustments and local adjustment layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that you wish 
to save, go to the Settings menu and select Save Preset. 
The Save Preset dialog will appear, with options for which 
module’s settings you wish to save, naming the preset, and 
adding it to an existing or new category. Nearly all of the 
Edit module settings can be saved as a preset, including 
cropping, retouching, text blocks and masks.

If you have applied a preset to an image, and subsequently 
updated any of the edit settings (or add or remove 
adjustments), you can update the preset with the new 
settings by choosing Update Preset with Current Settings 
from the Settings menu. This will only change the preset in 
your app; any images that had the old version of the preset 
will keep those settings unless you reapply the preset. (You 
can also update a preset by right-clicking on the preset in 
the Preset Browser.) 

If you would like to create a new preset category—which 
will be added to the Presets panel throughout ON1 Photo—
choose Add New Category from the category pop-up. 

MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

The Inset Preset option is only available  
when working in the Effects tab.

The Save Preset window includes all of the operations 
possible in the Edit module, with the exception of layer 
operations. Filled circles to the left of a setting mean that the 
setting will be saved in the preset; click the circle if you don’t 
wish that setting to be saved.
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Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and HDR 2020 will ask you to 
pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.

You can delete any preset, including the presets that came pre-installed with ON1 Photo. If you think you 
might wish to save a preset, export it first, then delete it.

Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category from 
the pop-up.

• Choose Rename category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset management options can also be performed by clicking on a 
preset in the Preset panel and right-clicking on the preset. This is helpful if you 
want to update, export or rename a preset without applying it to an image in 
Develop or Effects.

Nesting presets

To help manage large groups of presets, HDR’s Extras Manager lets you nest preset categories. See page 
7 for details on how to create and manage preset category subfolders.

Right-click on a preset category to get the 
category pop-up menu.
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RESETTING EDITS

Any edits you have made with ON1 HDR 2020 can be completely reset from within the Edit module. 

The Settings menu offers six options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom right of the Browse and 
Edit windows.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Crop: Returns the image to its original, uncropped size.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

NOTE: The Reset settings work on the currently selected layer, not on the file.
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Soft Proofing
ON1 HDR’s soft proofing feature lets you see 
how a photo will look when printed, using the 
color profiles that get installed with your printer. 
Soft proofing helps you determine where there 
might be issues when you print, so that you can 
adjust your tone, color and effects to give you a 
print that is closer to your editing vision.

Normally, when you’re viewing an image in 
HDR, you are viewing it through the lens of 
your monitor’s display profile. The color gamut 
of your computer’s display is wider than that 
of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, 
or by clicking on the soft proofing icon to the 
left of the Preview button at the bottom of the 
main HDR window. You soft-proof various paper 
types by choosing an installed printer profile 
from the Profiles submenu. The image will 
change to approximate the color of the paper 
you’re profiling. You can also turn on an overlay 
that will display out-of-gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in the 
View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

• Profiles: The Profiles submenu lists 
the currently available printer profiles. 
Choosing one will change the on-
screen display to use that profile. You 
can also import profiles via this submenu.

These three screen shots show the results of soft proofing options, as viewed 
in the Edit module. The top image is with soft proofing off (and is using the 
display color profile). The middle image is with soft proofing turned on, and 
using a printer profile for Epson’s Exhibition Matte Paper. The bottom image 
has the Gamut warning turned on; out of gamut colors are highlighted by the 
bright red overlay.
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• Intent: HDR offers two different rendering “intents” when soft proofing, which are used to 
convert the color from display to print. Perceptual shrinks the color gamut during the 
conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
HDR to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft proof 
is tone, contrast and color accuracy between screen and print. When 
using a home printer, use test prints to hone in on the right mix of Edit 
module adjustments. 

Other Edit Module Preview Options
In addition to soft proofing, ON1 HDR 2020 
offers a few other previewing options in the Edit 
module, which can be found in the previewing 
section at the bottom of the HDR window. With 
these options, you can compare the before 
and after views of a photo—in either split-screen or full-screen views—see the current mask, and turn soft 
proofing on or off. 

CHANGING THE MAGNIFICATION VIEW 

HDR includes various options for zooming in or out of a photo while you’re working on it. In addition to the 
Zoom tool and the Navigation pane (see page 34 and page 16, respectively), you can change the zoom 
view by moving the magnification slider. You can either click on the control and slide it to the right to zoom 
in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo 
printer. You can also import your own color 
profiles.

The Preview area at the bottom of the main HDR window includes options for 
adjusting the preview magnification, turning compare (before/after) view on or 
off, viewing the current mask, turning soft proofing on or off, and for viewing 
the original photo, with all edits removed.
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BEFORE/AFTER PREVIEWS

As you work in the Edit module, it can be helpful to see how individual edits—via items in the different edit 
tabs—affect your photo, as well as to see the cumulative changes made to the original image. The Edit 
module’s Compare mode displays a side-by-side view of your photo, with the original version on the left, 
the edited version on the right. There is a movable slider in the middle of the screen, which lets you view 
more or less of each view; click on the box at the center of the slider and drag it to the left (to view more of 
the edited image) or to the right (to view more of the original. While working in Compare view, you can use 
the magnification slider to zoom in or out of the image, which can be useful when you wish to see the 
effects of your edits on smaller sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

ON1 HDR 2020 has extensive masking capabilities throughout the Edit module. While you’re in the process 
of creating a mask, you have two options for displaying the contents of a current mask: 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

Edit’s Compare view displays a before/after view of your current photo, with a movable slider for expanding and contracting the 
different views.
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The overlays can be set in the Mask menu’s View Mode submenu while you are working in the Edit module. 
You can also, via this option, show the mask as a red overlay only when you are brushing a mask. 

You can toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by 
pressing the O key.

For more information on the varying aspects of masking in ON1 HDR 2020, check the respective masking 
tools earlier in this chapter, as well as the “Filter Masks” on page 57.

FOCUS AND CLIPPING VIEWS

Two additional previewing tools that can be quite powerful aids when you are editing photos are the 
Clipping and Focus Mask overlays. These options can be displayed in any of the Edit module tabs (as well as 
in the Browse module).

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or 
Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

The two options for viewing a mask are with a red overlay (left), which shows the masked areas in red, and a grayscale mask (right), which shows only the mask, in a 
range of tones from white (not masked) to black (completely masked). Tones in gray represent varying percentages of the mask’s opacity.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.
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Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Luckily, HDR’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will continue to be displayed even as you zoom in 
on a photo.

Showing or Hiding Edit Module Adjustments
You can also show or hide many individual 
adjustments made throughout the Edit module. 
Most of the panels in the Develop, Effects and 
Local tabs have a Show/Hide control in the upper 
left-hand corner of the panel. You can make your 
adjustments, and can click the control to turn the 
effect on or off. 

That this option is not solely for previewing an 
effect; if the adjustment is turned off, it will not be present in the edited image. This can be helpful if you’re 
trying different filters in Effects, for example, and you want to see if one looks better than another, or if 
you wish to see if it truly helps the photo or not. To turn the adjustment back on, click on the Show/Hide 
control so that the circle is filled.

The only adjustment inside the Edit module that cannot be turned off in this way is the Tone & Color panel 
in the Develop module. If you wish to view your photo without those adjustments, you need to press the 
Reset icon, which is represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in most Edit module panels, see page 54.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.

To turn an effect or other adjustment off, click on the Show/Hide control 
in the upper left of an adjustment’s panel. If the control’s circle is empty, 
that effect is not implemented. Clicking the control will turn it back on.
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PART 4: BASIC EDITING WITH DEVELOP

Develop is the module for performing basic global editing operations—adjusting tone and color, removing 
noise, sharpening and applying transforms to a photo. It is the perfect place to begin editing your photos. 

Develop Adjustment Panes
The Develop tab has four adjustment panes found in the Overall Settings panel. Unlike the Effects tab, 
which lets you stack filters in any order, the Develop tab’s adjustments are applied in the following order:

1.	 Tone & Color

2.	 Details

3.	 Lens Correction

4.	 Transform

WORKING WITH PANES

The Tone & Color pane is at the top of the stack, followed by the Details, Lens Correction and Transform 
panes. These panes are not removable from the stack, although you do not have to apply any of these 
operations to a photo. The remaining panes can be applied based upon what you wish to do with your 
photo. Clicking on the button to the left of the pane’s name will turn that pane on or off, which can be 
helpful if you want to see the effect in the context of other edits you have made. The Reset button—
designated by the circular arrow icon at the top right of each pane—will reset that pane’s settings to their 
default state.
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TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the bar, but the entire title bar 
is clickable). If you don’t want to have to scroll up and down the Settings panel 
when you have a lot of open panes, choose Solo Mode from the Window menu. 
This will leave only the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

TONE & COLOR

This pane adjusts the tonal and color characteristics of an image, 
letting you correct and enhance exposure, contrast, detail and 
color. It is split into two sections, Tone and Color, with a Color 
Profile option at the top of the pane.

Camera Profile

Camera profiles apply alternative interpretations of the raw data in 
an image based upon different genre types or intents. The pop-up 
menu displays HDR’s built-in profiles: ON1 Standard, Landscape, 
Portrait, Vivid and Neutral. If your camera has its own embedded 
profiles, you will see those profiles in the list as well, and you 
can also import your own custom camera profiles using HDR, 
and X-Rite’s ColorChecker and ColorChecker Camera Calibration 
software. (See page 51 for more information on how to create 
and import custom camera profiles into HDR.)

HDR’s camera profiles are non-destructive, and work 
independently of any changes you make to tone or color.

Tone

The Tone sliders control the global tonality, or brightness and  
contrast of the image. You can adjust each of the following:

• Manual, AI Match and AI Auto buttons: The AI Match button uses artificial intelligence 
technology to automatically adjust the controls in the Tone panel to closely match your photo 
as you saw it on the back of your camera’s display. The AI Auto button performs an automatic 
tone adjustment on your photo using a proprietary ON1 algorithm. If you don’t use either of 
these options, or if you make subsequent adjustments, the Manual button will be highlighted.  

• Auto Tone slider: This option is only available when using the AI Match or the AI Auto option. 
Using this slider will let you ‘fade’ the effect of those options.

• Exposure: Adjusting this slider to the right will lighten your image. Adjusting to the left will 
darken your image.

• Contrast: Increase or decrease the contrast in your image.

• Highlights: Darkens the highlights, recovering detail.
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• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing contrast in the shadows.

• Structure: Adjusts the detail in your image by changing the local contrast.

• Haze: When moved to the left, this will remove haze or fog from your photos; moving it right 
will enhance fog or haze.

NOTE: The AI Match and AI Auto buttons only affect the tone and saturation 
of your image; they don’t adjust the white balance. If you wish to change the 
white balance, use the Auto button in the Color section of the panel, or adjust 
the Temperature and Tint sliders as desired, as described below.

Color

The Color sliders control the Temperature, Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. By default, when working with raw (or DNG) files, the color temperature is 
measured in degrees Kelvin (°K), which gives you a larger and more accurate range to make adjustments. 

The settings in this section of the Tone & Color pane include:

• Auto Button: The auto button attempts to detect and remove a color cast. It makes 
adjustments to the Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click 
on an area in the image that should be gray.

• White Balance presets: This pop-up lets you change the white balance according to common 
color temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, 
Custom). The default is As Shot, which is the color temperature that the camera recorded 
when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow). When editing 
a raw file, the °K button will be blue, which means that the temperature is measured in 
degrees Kelvin. Clicking the button will change the slider to a relative color ramp. (The Kelvin 
ramp is only available when working with raw photos; other formats use the relative slider.)

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases/decreases the color of muted tones, leaving more saturated colors alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.
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DETAILS

The Details pane incorporates sharpening and noise reduction, two 
adjustments that often compete with each other when working on 
a photo. We’ve added them together into a single pane to help you 
achieve the right balance between sharpness and noise during your 
initial photo editing. 

Sharpening

The sharpening section of the Details pane is designed to help 
visually sharpen an image based on its initial state from your 
camera—for example, to bring back some sharpness that might 
have been lost. It has two basic controls: Amount and Threshold. 
Amount controls the strength of the sharpening applied, while 
Threshold reduces sharpening in areas of low detail via a threshold mask. 

If you hold down the Option (Mac) or Alt (Windows) key as you adjust the Amount slider ON1 Photo will 
display your photo in grayscale, which can make it easier to view the degree of sharpening you’re applying.

With the Threshold slider, a setting of 0 means that the sharpening amount gets applied to every 
pixel. As you increase the amount, it focuses the sharpening only where there is a difference between 
neighboring pixels. To help you determine which edges are sharpened, you can use the same Option/Alt 
key trick mentioned above. In this view, as you adjust the Threshold slider, everything that is white will get 
sharpening applied to it; everything displayed as black will not have sharpening applied.

NOTE: When you are adjusting the sharpening or the noise in a photo, it is 
best to be working at 100% view. To do this, you can click on the 100 button in 
the Navigator pane, choose View Actual Pixels from the View menu, or press 
Command-Option-0 (Mac) or Control-Alt-0 (Windows) on your keyboard. 

Noise Reduction

The Noise Reduction section reduces luminance and color noise, while maintaining image detail. By default, 
ON1 Photo applies a small amount of noise reduction on your photo, based on the camera type used. You 
can then further refine both luminance and color noise, as defined below:

• Luminance: Adjusts the overall strength of the noise reduction applied to the luminance or 
detail of the image. Hold down the Alt/Option key to see just the luminance while adjusting 
this slider.

• Color: Controls the amount of noise reduction applied just to the color noise or chroma, of 
the image.

• Detail: Controls how much edge detail is protected. Hold down the Alt/Option key to see the 
edge mask while adjusting this slider.

• Remove Hot Pixels: If you have any individual, blown-out pixels in your image, turning 
this setting on will remove them, changing that pixel’s color to one that blends in with the 
surrounding pixels. This setting can also be helpful in reducing noise in long exposures.
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The Details pane is intended to adjust the base-level sharpening and noise reduction of a photo. If you wish 
to apply further sharpening for printing or other output uses, you can add more targeted sharpening in the 
Effects tab, or the Print window, if you wish to sharpen for output. 

NOTE: ON1 HDR 2020 uses an improved noise reduction engine, which is 
available via the Version pop-up in the Details panel. In order to provide editing 
compatibility, photos that have been edited in previous versions will default to 
the 2017 noise reduction model, while new photos that are edited in ON1 HDR 
2020 will default to the new model. You can change any image to the other 
model via the Version pop-up.

Styles

The Details pane has a set of built-in styles in the top part of the pane. Styles are like preset adjustments 
for a pane: they provide a group of settings to help you get started in the pane, or to apply a specific effect.

You use a style by clicking on the style’s icon in the pane, and then can adjust the sliders as desired to get 
the right effect for your photo.

You can save your own settings as a style. Simply click on the More icon on the far right side of the styles 
list for that pane, then choose Save New Style from the pop-up. Name your style, and it will then be 
added to the top of the More menu. To apply a saved style, choose the style from the More pop-up menu. 
To adjust the settings for a saved style, apply it, make any changes you would like to the sliders or other 
options, then click on the More pop-up and choose Update Style with Current Settings from the menu.

LENS CORRECTION

The Lens Correction pane detects the lens used in a photo (from 
its metadata), and searches ON1 Photo’s internal lens database 
for an appropriate profile. If found, the profile will be applied 
automatically, reducing distortion, chromatic aberration and 
peripheral fall-off. 

NOTE: Lens profiles can only be applied to raw photos 
that are opened via ON1 HDR. If you use HDR as a plug-in 
from Lightroom, lens profiles will not have any effect on 
your photo, although adjustments made in the Manual 
section of the pane will get applied to your final photo.

If HDR doesn’t have a built-in profile for your lens—or you wish to apply further correction to a photo—you 
can make manual adjustments by clicking on the Manual triangle. There, you can adjust either pincushion 
(where lines in a photo curve inward) or barrel (lines curve outward) distortion by moving the slider to the 
right or the left. The Manual section also can help remove any purple or green color fringing that might 
occur along edges, and can reduce the light fall-off (vignetting) that can occur at the outer edges of a lens.
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TIP: If you have a lens that isn’t in the profile database, open a typical photo 
shot with that lens, and adjust the Manual settings in the Lens Correction pane 
to fix any lens abnormalities. Save these settings as a style by clicking on the 
Style pop-up and choosing Save New Style. When you open additional photos 
shot with that lens, choose that Style from the Style pop-up.

A list of the currently supported lens profiles can be found on the ON1 support website, via this link.

TRANSFORM

Transform applies distortion and perspective correction to your 
image, and offers rotation and scaling options as well. You can 
use these settings to make small adjustments to perspective or 
distortion.

The three icons at the top of the pane let you apply specific 
transforms to the current photo:

• Keystone lets you project your image as if it were on 
an angled surface. This type of effect is often used to 
help adjust the perspective in architectural photos. 
Selecting the Keystone option will give you a box with 
four handles at the corners. You can extend the handles in any direction. Once you’re done, 
click on the Apply button at the center of the keystone box.

• Level works in a similar fashion to the one found in the Crop tool (found on page 20). 
Select the tool and click and drag across an element in your image that should be level.

• Move lets you adjust the image’s position on the canvas. Click and drag to reposition.

Keystoning can be helpful when you want to adjust the perspective in a photo; just adjust the four corners 
to align with an object that should have parallel lines, like a window or door, then click the Apply button. 
The Transform pane doesn’t apply a crop when you apply a transformation; you’ll need to use the Crop tool 
to do that.

In addition to the above tools, the following options will apply specific transform operations:

• Vertical: Adjusts the vertical perspective.

• Horizontal: Adjusts the horizontal perspective.

• Rotation: Rotates the canvas up to 45° clockwise or counterclockwise.

• Scale: Scales your image up from the center, to 100%.

• Aspect Ratio: Stretches your image horizontally (moving the slider to the left) or vertically (to 
the right).

• Shift: Translates the image left or right.

• Rise: Translates the image up or down.
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The Grid pop-up menu at the bottom of the Transform pane lets you displays a grid overlay while you are 
adjusting the pane’s sliders. The default for the pane is No Grid, but you can also choose between 10% 
(large), 5% (medium) or 1% (fine) grid settings.

The Transform tool works best most of the time in small amounts. It’s not necessarily going to fix a photo 
with an extreme perspective, but it can often help with slight adjustments, especially if you fine-tune them 
with some of the Transform panel’s other controls or the Manual section of the Lens Correction panel. In 
addition, the tool does not apply a crop after an operation; if you are happy with the transform results, use 
the Crop tool to finish your work.

CREATING AND ADDING CUSTOM CAMERA PROFILES

As noted in the section on the Tone & Color panel (page 46), you can create your own custom camera 
profiles and import them into HDR. Custom camera profiles can help improve the fidelity of color 
reproduction in your photos, and for some photographers, this can be a useful tool. 

To build a new profile, you’ll require a color profiling target and special software that creates the profile. 
ON1 worked with X-Rite Inc. during the development process to create a workflow that helps ease this 
process and ensure consistent results when building camera profiles. In addition to ON1 HDR 2020, 
you’ll need a reference target, such as one of the ColorChecker series, and X-Rite’s ColorChecker Camera 
Calibration app. 

The Transform pane’s Keystone option can help with perspective issues in a photo. Clicking the Keystone icon gives you a box that you can use to align the four 
corners of an object that should have parallel lines (above left). Once you have the edges of the object aligned, click the Apply button in the center to create the 
transform, and apply a crop as necessary. (Sometimes, you’ll find that using the manual section of the Lens Correction pane can help reduce some of the distortion 
that the Keystone operation can create.)
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The process for creating a custom profile is as follows:

• Turn off automatic white balance on 
your camera; set it to the lighting 
conditions—daylight, tungsten, flash, 
fluorescent—in which you are shooting 
the target.

• Place the color reference target in the 
center of your scene, with even light. 
Take the photo.

• Open the photo in HDR’s Develop tab.

• In the Camera Profile section of the 
Tone & Color panel, choose the Linear 
Raw profile from the pop-up.

• Click on the dropper icon in the Color 
section of the Tone & Color panel (see 
page 47), and click on one of the 
light gray patches in the target. This 
will neutralize the image.

• Using the Export feature, export 
your photo as a TIFF, selecting the 
Camera Calibration color space from 
the pop-up under the file type option. 
(See page 77 if you need help with 
exporting photos from HDR.) 

• Using X-Rite’s ColorChecker Camera 
Calibration software, open the 
exported TIFF file. The app should 
find and align the target; if so, click 
the Create Profile button, and save 
the exported profile. If it doesn’t find 
the target, follow the guidelines in 
the software to help improve your 
chances with a new photo.

• In HDR, go to the Develop module 
with a photo created with the camera you profiled. In the Tone & Color panel, click on the 
Import Profile item in the Camera Profile pop-up menu. Find the exported profile and choose 
Open. Your profile is now installed.

NOTE: You can find the different ColorChecker options on the X-Rite website 
at xritephoto.com/camerasolutions.

When you open the photo with the color target, set the camera profile to 
Linear Raw, and use the gray dropper to neutralize the photo, by clicking on 
one of the light gray targets (circled, above).

When exporting your neutralized target, set the 
file type to TIFF, and the color space to Camera 
Calibration Space.

Using X-Rite’s ColorChecker Camera Calibration app, you can open the 
exported TIFF file, and create your own custom camera profile. Then, import 
the profile via the Camera Profile pop-up in Develop to use it with any photos 
taken with that camera.
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PART 5: STYLIZING WITH EFFECTS

If Develop is the base from which you start editing your photos, Effects is the finishing school. With eight 
filters that can be stacked in any order, and with extensive blending and masking options, Effects lets you 
create stunning, pro-level photos with ease. And, since it is built upon ON1 HDR 2020’s non-destructive 
editing engine, you can go from Develop to Effects to Local and back again, preserving your edits, masks 
and more without having to worry about saving multiple versions of your files.

While Develop and Effects share the same tools, Effects is much more customizable in how adjustments—
called filters in Effects—are applied. The editing stack inside Develop is fixed, while the stack in Effects is 
extremely flexible. Here are just a few of the things you can do with an image in Effects:

• You can add filters in any order (even multiple instances of the same filter).

• Move filters up and down in the stack.

• Add blending options to all or some of the filters and set the opacity of each filter individually.

• Create complex masks for each filter you add, letting you selectively apply a filter to specific 
portions of an image.
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Filters
Filters are the building blocks of Effects’ editing power. Each filter is an adjustment type, much like the 
basic adjustment panes inside Develop, but Effects filters have much more functionality than the Develop 
panes. Each filter is like a movable, editable layer over the base image you are working on. You can use 
Effects’ masking tools to apply a filter to only part of an image and can change the blending mode (and 
opacity of the filter) to alter the way the filter interacts with those above and below it in the stack.

The Effects tab has eight filter types, added either by the Add Filter button found at the top of the Effects 
tab, or via the Filters pane on the left side of the window. You can apply filters in any order, and you can 
have more than one instance of a filter in the stack. (This can be helpful when you are creating complicated 
masks on an image and wish to apply the same filter differently in parts of the photo.)

FILTER OVERVIEW

Each filter pane has a different set of adjustment 
options and controls, but every filter pane has the 
same five sections:

A.	Filter on/off button (left); Show/Hide 
Mask (right)

B.	 Displays blending mode options (left); 
Resets filter (middle); Deletes filter from 
the stack (right).

C.	 Filter opacity setting.

D.	Styles pane for filter presets.

E.	 Control area for adjusting that filter’s 
specific settings (dependent upon the 
filter chosen).

APPLYING FILTERS WITH THE ADD FILTER BUTTON

If you click the Add Filter button at the 
top of the Effects tab, the Filters window 
opens up, with a list of all nine filters. If 
you run your cursor over a filter name, 
the right side of the window will have 
a small before/after thumbnail, a short 
description, and a list of keywords that 
relate to that filter. To add a filter, click 
once on the filter name, and it will add it 
to the stack, above the current filter. If 
there aren’t any filters in the stack, the 
new filter will be at the top of the stack. 
You can click and drag the title bar in any 
filter to move it up or down in the stack.

The Filters window opens when you click on the Add Filter button at the top of the 
Effects tab.

Overview of a filter—in this case, the HDR Look filter—inside Effects.
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If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. HDR will then narrow down the search to those filters that match 
your search terms.

APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel, Effects has an 
additional Filter panel on the left side of the 
screen. This panel lets you browse all of the 
filters inside Effects, and display previews of the 
available styles for that filter. 

To choose the Filters panel, click on the Filters 
tab. A list of the filters will appear, and clicking 
on a filter will display thumbnails of your image 
with that filter’s available styles. To choose one, 
click on the style, and Effects will add that filter 
to the Overall Settings pane. Note that this will 
replace the currently selected filter in the stack; 
to add a new one on top of the stack, click the 
Add Filter button at the top of the Effects tab on 
the right, then choose a filter from the list. (You 
can also click and drag the title bar of any filter 
and move it up or down in the stack.)

If you’d like to see a larger representation of 
what your selected photo will look like with a 
filter’s styles, click on the Quick View Browser 
icon in the category’s title bar. That will display a 
window with all of the presets in that category. 
(Press the Escape key to close the Quick View 
Browser.)

To change the size of the thumbnails in the filter 
styles panel, select the Browser Mode option 
from the View menu and choose One, Two or 
Three Column Thumbnail View. (If you choose 
Thumbnail from the Browser Mode submenu, 
the Filters and Presets panels will display as 
thumbnails.)

If you’d like help with what the different filter operations do, click on the Info button at the top right of the 
panel. With that button checked, when you hover over a filter, HDR will display a small pop-up window 
containing the same description (with before/after thumbnail) found in the Add Filter window. Click the 
Info button again to turn off this display.

Searching for filter styles inside the Filter Browser

To search for styles inside the Filter Browser, type in the name in the search field at the bottom of the 
panel. The search results will appear in a new subfolder called ‘Search Results.’

The Filter Browser has a list of all the filters available in Effects (left). Clicking 
on a filter will display thumbnails of the filter’s styles using your photo (right). 
You can also click the icon on the right side of any filter to view the styles in 
the Quick View Browser.
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Saving filter styles as favorites

If you hover over a filter style’s thumbnail in either the Filter Browser or the Quick View Browser, you’ll see 
a heart icon. Clicking the icon will add that style to your Favorites category. This category resides at the top 
of the filter list, and contains all filter styles you have selected as a favorite. To remove a favorite, open the 
Favorites category, and click again in the heart icon.

To apply a style to a photo, simply click on the style in the Filter Browser or in the Quick View Browser.

WORKING WITH FILTER PANES

By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, you 
will see those filters in the stack. Clicking the button in the top left corner of the filter pane will turn that 
effect on or off, which can be helpful if you want to see the effect in the context of other edits. If you don’t 
like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset button, which is next to 
the Delete button, represented by ‘⟲,’ will reset that pane’s settings to their original state.

To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title 
bar is clickable). If you don’t want to have to scroll up and down the filter stack 
when you have a lot of open panes, go to the Window menu and choose Solo 
Mode. This will leave the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

STYLES

All of the Effects filters have a set of built-in styles 
in the top part of the pane. Styles are like preset 
adjustments for a pane: they provide a group of 
settings to help you get started in the pane, or to 
apply a specific effect.

You use a style by clicking on the style’s icon in the 
pane, and then can adjust the sliders as desired to get the right effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from the 
More pop-up menu. To adjust the settings for a saved style, apply it, make any 
changes you would like to the sliders or other options, then right-click on the 
More pop-up and choose Update Style with Current Settings from the menu.

Styles for the Vignette filter.

Saved styles appear at the top of 
the More menu.
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FILTER MASKS

Every filter (and local adjustment) has a mask associated with it, which lets you apply that filter’s effect to 
specific areas of an image, using the Masking Brush (or the Local Adjustment Brush and Gradient, when 
working in the Local tab) and Masking Bug tools. By default, the mask is white, which means that the effect 
is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ the effect in 
areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask and choose 
to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

HDR has two options for viewing the contents of a mask: either as a red overlay on top of your image (the 
default) or a view only of the mask itself, represented as grayscale. These options are available from the 
Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch between the 
two modes. (HDR will remember the previous settings.)

The Mask section of any effect or local adjustment has the following contents, as shown below (using the 
Dynamic Contrast filter as an example):

A.	The Show/Hide Mask icon, which displays the 
contents of the current mask. The default mask 
contents are white when you add an effect, and 
black when you add a local adjustment layer.

B.	 Sets the overall opacity of the mask.

C.	 Larger display of the current mask, with buttons 
to invert, reset, copy, paste, and view/hide the 
mask contents. The Lumen button creates a 
luminosity mask of the image.

D.	Density adjusts the overall mask density from 
black (100) to white (0). Feather blurs the mask.

E.	 The Levels and Window settings let you adjust 
the black and white points of the mask, fine 
tuning them in different ways.

F.	 The Color Range option lets you choose a color 
(selected via the dropper tool), and make or tune 
the mask based on the range of the color selected.

Overview of the Mask Options section of a filter pane in Effects, 
showing a luminosity mask. Mask Options is also applicable 
when working in the Local Adjustments tab, or on a layer in the 
Layers pane.
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Luminosity Masks

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside HDR. 
This mask uses the brightness (or luminance) values in your image to let you target specific tonal ranges 
with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very specific 
areas of an image.

To add one of these masks, click on the Lumen button in the Mask options area or choose Create 
Luminosity Mask from the Mask menu. If you view the mask, you will see that it looks like a black-and-
white version of your image. With a luminosity mask, your effect will be applied in an increasing amount 
depending upon the brightness value of the pixel underneath: if the pixel is black, none of the effect will be 
applied; if it is white, it will be entirely applied; for all other tones, the effect will get applied as a percentage 
of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 
bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will help 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors will be 
selected, higher numbers mean that more.

A photo with the luminosity mask displayed in Grayscale mode (set using the settings from the Mask menu’s View Mask option). 
Viewing the mask can help greatly when refining a luminosity mask via the Density, Feather, Levels and Window controls.
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Masking tips

Here are a few tips for working with the various options in the Mask pane:

• You can use multiple masking tools to create and modify masks. For example, you can start 
with a luminosity mask, adjust the tonal range of the mask with the Levels or Window sliders, 
and then further refine your mask with the Masking Brush or Masking Bug. A luminosity mask 
always overrides the current mask, however, so you should start there.

• Use the Feather slider to smooth transitions between masked and unmasked sections.

• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 
like a ‘reverse fade’: at the 100, all of your mask is viewable, at 0, the mask is entirely white.

• Because it can sometimes be helpful to use the same mask on different filters, use the Copy 
button to grab the contents of a mask from one filter and the Paste button to paste that onto 
the mask of another filter.

DELETING A FILTER

You remove a filter by selecting it and pressing the ‘X’ icon to the right of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter to an image, but would like a faded, muted color effect, 
reduce the opacity of that filter. The more you reduce the opacity, the less effect the filter will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 HDR 2020’s blend modes also let you apply a blend mode to specific colors or 
tones in your image, making them a very useful tool for precision editing of your images. You can apply 
sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending Options gear icon at the top of a filter’s pane. The 
Blending Options area will drop down from the top of the panel. The blending option controls are:

• Blending Options: A pop-up list of blending modes. There are 24 common blending modes 
available in the list, including Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.
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• Apply To: This lets you apply the blending mode to a specific color or tonal range. The 
options are; All (the default), Highlights, Midtones, Shadows, Reds, Greens, Blues, Magentas, 
Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can also manually choose a 
color range by selecting the Dropper Tool in the pane and clicking on a color in your image.)

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts the 
selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your 
adjustments.

How blending modes work

At their basic level, blend modes determine 
how the pixels on one layer interact with the 
layers below it. With 24 blend modes in ON1 
HDR 2020, it might be difficult to know which 
ones to use in any given situation, but they can 
easily be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. Most often, when you know how you want to apply an effect 
—by darkening, for example—you’ll need to perform a bit of experimentation with the different modes in 
that category to determine which mode works best.

MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master blend mode options for the entire image stack, and includes a 
Master mask option. The Master Opacity slider, found at the top of the Effects tab, controls the strength of 
the composite filter stack against the original image—if you haven’t performed any other editing operations 
on it—or against the image as it has been inside the Edit module.

The Master Blend Mode options can be accessed via the gear icon at the top of the Edit tab. It has the same 
controls as the blending options in the individual filter panes.

To create a Master mask, click on the mask icon next to the Save Preset icon in the Edit tab. This mask 
works on the entire effects stack, letting you selectively add or remove an entire effect.
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Filter Types
Effects has eight filter types available for you to use inside ON1 HDR 2020. Each filter has a set of styles in 
the top row, providing a range of popular or useful options for using that filter. You can also save your own 
preset styles by clicking the More pop-up at the end of the Styles row.

BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, with some additional toning features.

The styles at the top of the pane represent different filter types 
often applied to an image, while the Auto button selects the black 
and white points of your image automatically. To manipulate the 
tones manually, move the color range sliders to the right (increasing 
brightness) or the left (decreasing). Alternatively, you can choose 
the Channel Mixer option from the Conversion pop-up, and use 
the slider to choose a look that accentuates the color tones you are 
most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane lets you adjust 
brightness, contrast, highlights and shadows, whites and blacks, 
and detail, directly within the filter pane.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing contrast in the shadows.

• Compression: Compresses the tone to reveal highlight and shadow detail.

• Detail: Increases the local contrast in the image.
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Toner

The Toner section of the filter is designed to approximate many traditional and popular darkroom-based 
paper toners, from sepia tones to platinum, selenium, coffee and more. You can choose from more than 20 
toning options via the Type pop – up menu, and adjust the combination of paper (which is represented by 
the Highlights section of the pane) and silver (represented by the Shadows). To tune your options, you can 
adjust the Hue or Amount of each setting, and use the Swap tones icon (next to the Highlights color well) to 
swap the highlights and shadows colors. The Preserve Whites and Blacks button keeps the pure whites and 
pure blacks neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, like the Toner section, is designed to add 
a classic film grain look to your photos. To add film grain, choose from the drop-down list of popular black 
and white films. The Amount slider controls the strength of the effect, while the Size slider adjusts the 
scale of the grain.

CURVES

The Curves pane is a powerful, advanced tool for adjusting contrast 
and color in your image. The buttons at the top of the pane let you 
adjust the composite RGB channel, or you can adjust the individual 
Red, Green or Blue channels independently.

In the main part of the pane, the left side of the X-axis represents 
the dark tones in your image, while the right side represents the 
light tones. By clicking on the line at the center of the pane and 
dragging it up or down, you adjust those specific tones making 
them lighter or darker. (It is often helpful to keep an eye on the 
Histogram when making adjustments with Curves.)

DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.
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GLOW

This pane adds a soft-focus glow to the image. Adjustable settings 
for the Glow pane include:

• Amount: Controls the overall glow strength.

• Halo: Sets the radius of the glow effect, creating a 
fuzziness to your image’s edges.

• Mode: Lets you set the blending mode for the effect.

HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading effects to film, and they are 
increasingly popular in still photography. The Styles section has 
default effects you can apply, and you can also import your own 
LUTs, by clicking the Import button inside the filter. (HDR imports 
common LUT file formats, including .3DL and .CUBE file types.)

• Category: Lets you choose from one of the pre-installed 
LUT categories, or any imported categories .

• LUT: Displays the available LUTs within the chosen category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See page 7 for information on how to use the Extras Manager to 
import LUTs into HDR.
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SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 HDR 2020 offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which one 
you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the sharpening effect. Smaller amounts 
keep fine detail, while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.

VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from square to round.

• Type: This drop-down menu lets you select a Normal, Subtle, or Soft vignette effect. The 
Priority option will let you preserve highlights (using the Tone & Color pane in Develop) when 
applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.
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PART 6: LOCAL ADJUSTMENTS
You can easily make local adjustments to portions of an 
image in ON1 HDR 2020. You can apply these adjustments 
using either the Adjustment Brush or the Adjustable 
Gradient (or both, if desired). You can create as many local 
adjustments as you need on an image (by clicking on the 
Add Layer button at the top of the Local Adjustments 
section). 

Local adjustments can be used to apply a gradient filter to 
darken a sky, for example, or to add a more complicated 
vignette to an image. Local adjustments are in essence a 
mask that is applied to a portion of your image, and you 
can manipulate those masks in powerful ways with both 
the blending modes and the luminosity options in the Local 
tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), 
color (white balance, saturation and vibrance) and detail 
(structure and noise). Each local adjustment layer can have 
completely different settings and work on different parts 
of your image. You can also use local adjustments to paint 
with color over part of a photo, to perform specialized 
tasks such as skin retouching or to replace the color of an 
object. 

Local adjustments are independent from the Develop 
and Effects tabs; you can create a local adjustment while 
working in Develop, switch to Effects, and when you click 
on the Local tab, your local adjustments remain intact.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

The Local Adjustments tab
To create a local adjustment, click on the Local tab. If there are no local adjustment layers present, HDR 
will add one. If you want to add additional adjustment layers, click the Add Layer button. The top of each 
adjustment layer includes the following options:

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of canned styles for you to start with, including ones for 

Adjustment panes let you adjust basic tone and color settings 
on the parts of the image you choose. You can also set the 
opacity of the adjustment, as well as apply masks (via the mask 
icon, top) and advanced blending options (accessed via the gear 
menu).
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lightening or darkening (dodging and burning), adding vibrance, fixing teeth or red eye, and 
many more. (You can also save your own styles via the More pop-up menu.)

The main section of the Local tab has all of the same options found in the Tone & Color pane in the 
Develop tab: Exposure, Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, Saturation and 
Vibrance. In addition to those settings, the local adjustment pane includes a Noise slider, designed to help 
reduce noise on a targeted level (most often seen in the shadows).

These controls work the same way inside the Local Adjustments panel. One difference is that, since a local 
adjustment is actually a layer that sits on top of your global adjustments, ON1 HDR 2020 provides you with 
a number of blending options for each adjustment. Blending modes determine how the selected layer blend 
with the items below it in the image stack.

Click on the Blending Options gear icon at the top of the Local tab to drop down the Blending Options. The 
blending option controls are:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in 
the list, including Normal, Lighten, Darken, Screen, 
Multiply, Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode 
to a specific color or tonal range. The options are; 
All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, 
Flesh Colors, Vivid Colors and Neutrals. (You can 
also manually choose a color range by selecting the 
Dropper Tool in the pane and clicking on a color in 
your image.) 
 When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, or saturation range specified. The Range 
slider expands or contracts the selected option, and the Highlights, Shadows, and Skin sliders 
protect those settings from your adjustments.

ABOUT BLENDING MODES

At their basic level, blend modes determine how the pixels on one layer interact with the layers below 
it. With 24 blend modes in ON1 HDR 2020, it might be difficult to know which ones to use in any given 
situation, but they can easily be grouped into Normal (the default mode) and five categories: Darken, 
Lighten, Contrast, Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies the effect to all of the pixels in the adjustment (or effect), 
assuming the layer opacity is 100%.

The other modes apply different levels of that category’s effect using various mathematical formulas, 
and sometimes it can be hard to know which mode will work best with what photo. Most often, when 
you know how you want to apply an effect—by darkening, for example—you’ll need to perform a bit of 
experimentation with the different modes in that category to determine which mode works best. (See 
“Blending Modes” on page 59 for more information.)

The Adjustment pane’s Blending controls give you extensive 
options for applying local adjustments to targeted tonal and 
color ranges in an image.



ON1 HDR 2020 User Guide	 Part 6: Local Adjustments	 67

Painting with Color

The Paint with Color option at the bottom of the local adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by blending existing color, and to replace the color of an 
existing object. 

The Paint with Color section has three options, Solid 
Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your 
image by clicking on the eyedropper icon, or you can 
click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a middle tone section of 
skin, and, using a low opacity setting on your brush, you can paint over parts of the skin with the brush. 

Working with Local Adjustments
When adding a local adjustment layer, click on the tool you wish to use in the Tool Options bar at the top 
of the window. The Adjustment Brush is perfect for working with specific subjects or areas in an image: 
a person or primary object that you wish to brighten, shadow areas that you wish to darken, and more. 
It works in the same manner as the regular Masking Brush: you set the paint mode (in or out), brush size, 
feather and opacity, and brush in the areas you wish to paint an effect in or out.

The Adjustable Gradient is designed to apply a gradient mask over a section of an image: most commonly to 
darken a sky, for example. Because the local adjustment tools are for working on a mask, you have all of the 
masking and blending options you have throughout HDR, and you can use one or both tools—in addition to 
the Refine, Chisel and Blur Mask tools—to refine your adjustment mask as desired. 

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

TIP: To see the mask created by the Adjustable Gradient, choose Show Mask 
from the View menu. You can choose a red overlay, which presents the mask 
over your image, or grayscale, which shows the mask as black to white tones. 
These views can be helpful in understanding how these gradients work.
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Manipulating a Linear Gradient Mask 

Once you’ve added a gradient to an image, you can 
modify it by accessing the parts of the gradient overlay: 

• To move a gradient, click on the big circle at 
the center of the gradient and drag. 

• To resize a radial gradient, click and drag on the 
solid line. 

• To adjust the feather (hardness) of the mask, 
click and drag along the dashed line. 

• To rotate the mask, click the smaller circle near 
the gradient center and drag. 

When working with local adjustment masks, all of the tools in the Refine group—the Refine Mask, and the 
Chisel and Blur tools—can be used to help give you create smoother and more realistic masks.

Other masking options

Every local adjustment has its own mask, and it uses the same masking options and controls found in 
Effects and Layers. To access the mask, click on the mask icon in the title bar of the local adjustment layer. 
There you can copy and paste masks, create luminosity masks, and create masks based on color ranges. For 
specific details on how to work with these masking options, see “Filter Masks” on page 57.



ON1 HDR 2020 User Guide	 Part 7: Combining Photos with Layers	 69

PART 7: COMBINING PHOTOS WITH LAYERS

The Layers functionality inside ON1 HDR 2020’s Edit module lets you create quick composites, blend 
multiple images together, paint in new skies or backgrounds, align layers based on their content, and much 
more. And, because Layers is tightly integrated within the Edit module, all of your work remains re-editable 
at all times: you can go back and add, change or update any setting, on any layer.

You can combine multiple photos or copies of the same photo as layers. Each layer can be moved, sized and 
masked on its own. But more than that, each layer has its own non-destructive settings—just like any photo 
in HDR, all the way back to the original raw data. That means you can use all of HDR’s editing features—
basic exposure changes, camera profiles, Effects filters and more—as part of a layered photo.

When you add a layer to a photo, HDR 
automatically creates a new document with an 
.onphoto extension, leaving your original photo 
intact. This document type contains all the 
layer information and non-destructive editing 
operations made inside HDR. 

Layers can be as simple as copies of the current photo, to apply more complex adjustments to portions of 
an image than you could with local adjustments. You can also add other documents as a layer inside the 
current document, for replacing skies or other backgrounds, for adding textures, or for when you wish to 
create complex collages. HDR supports up to 14 layers in a document.

The Layers feature inside ON1 HDR 2020 is fully non-destructive. This means you can use all of the Edit module’s tools, tabs and filters, along with layer-
independent masking capabilities, and still preserve your original photos and can come back at any time to further enhance your creations. 
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Once you have added a layer, the entire Edit module is available for that layer. When you click on a layer, 
you can add any adjustment from the four edit tabs, create masks, and more. You can use the Transform 
tool to move, rotate, and scale the contents of a layer independently from the complete document. 
(Because the Crop tool works at the document level, you can’t crop individual layers.)

OPENING A LAYERED PHOTOSHOP FILE

ON1 HDR 2020 can open most layered Photoshop files in the Edit module. What happens depends upon 
the composition and type of layers in the document:

• If the layered document has basic Photoshop layers and masks, HDR will open the document 
inside Edit, with each layer and mask visible in the Layers pane. 

• If the Photoshop file has specialty layers—smart objects, text layers, layer styles— HDR will 
flatten the visible layers and let you work on a composite.

In either case, HDR will convert the file to an .onphoto file, preserving your previous document.

WORKING WITH THE LAYERS PANE 

The Layers pane is fairly straightforward, with three sections:

A.	Layer Opacity: Reflects the opacity of 
the currently selected layer.

B.	 Layers: All of the layers in your 
document are listed here, with a 
thumbnail of the layer contents and the 
layer mask (if there is one); the currently 
selected layer has an colored outline 
around it (based on the Accent Color 
chosen in the System Preferences’ 
General tab). You can rename a layer by 
double-clicking on the title.

C.	 Layer Tools: The toolbar at the bottom 
of the Layers pane includes buttons 
for (from left to right) adding a layer, duplicating the current layer, deleting the current layer, 
merging layers, and setting a layer’s blending options.

Accessing Layer Commands

Most of the layer commands in HDR can be accessed via the 
Layers menu, the toolbar at the bottom of the Layers pane, and 
a pop-up menu that you get when you right-click on any layer. 

The Layers pane in HDR. This photo has four active layers.

Right-clicking on a layer brings up a list of available 
Layers operations.
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Layer Visibility 

A layer’s visibility can be turned on or off by clicking the button to the left of the layer thumbnail. When 
turned off, the layer has no effect on the composite image. 

Changing Opacity 

The opacity slider controls how opaque or how strong the selected layer is. The default is 100%. At lower 
settings, the layer will blend with the layer(s) under it. Altering the blending mode and opacity of a layer can 
create a wide range of color and tone effects. 

Changing the Layer Order 

You may change the order of layers by dragging and dropping layers into the order you prefer. 

Renaming Layers 

You can rename a layer by double-clicking on it. The name turns into an editable field. Type in your 
preferred name and press Enter. 

Deleting a Layer 

You may delete a layer by selecting the layer, then choosing Delete Layer from the main Layer or pop-up 
menus, or by pressing the Delete button in the toolbar. 

Resetting layer mask and transform operations

Choosing Reset Layer Properties from the Layers menu or the pop-up will delete any layer masks or 
transform operations made to the current layer. To reset Develop or Effects settings or local adjustments 
made to a layer, click the Reset Layer button at the bottom right of the main Edit module window. 

Duplicating a Layer 

You may duplicate or copy the current layer by pressing the Duplicate Layer button in the pane’s toolbar, or 
by right-clicking on the layer and choosing Duplicate Layer from the pop-up menu. 

Merging Layers 

You can merge two layers together: by selecting the top layer (of the two) and clicking on the merge button 
in the Layers pane’s toolbar, by right-clicking on the layers by selecting them and pressing the Merge button 
in the toolbar, or via the Layer menu or the layer pop-up menu. The merged layer will inherit the name of 
the top layer.

You can also merge all visible layers by choosing Merge Visible from the Layer menu or pop-up. The merged 
composite will use the name of the layer that was selected.

Creating composites from layers

Sometimes, you’ll want to create a composite of all the layers in your file, maybe to perform some final 
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finishing in Effects or Develop, or to preserve your current layer state (like a snapshot). To create a 
composite, choose Create Stamped Layer from either the Layer menu or the pop-up menu. All visible layers 
will be merged into a composite that is placed at the top of the Layer stack.

Changing blending modes 

Blending modes determine how the selected layer blend with the layer(s) below it. The default blending 
mode is Normal. This maintains the full opacity of the upper layer. Layers also supports many other 
blending modes which can be used to alter the brightness, contrast and color of the image. 

How blending modes work

At their basic level, blend modes determine 
how the pixels on one layer interact with the 
layers below it. With 24 blend modes in ON1 
HDR 2020, it might be difficult to know which 
ones to use in any given situation, but they can 
easily be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. 
Most often, when you know how you want to 
apply an effect —by darkening, for example—
you’ll need to perform a bit of experimentation 
with the different modes in that category to determine which mode works best.  

Layer masks 

If you use any of the masking tools, a layer mask will be created automatically. Clicking on the layer’s mask 
icon will display the standard HDR mask options, and you can use all of the Edit module’s masking tools 
to create or modify layer masks. You can also copy and paste layer masks—including masks from Effects 
filters—via the Mask options section or via the Mask menu. See page 25 for more on using HDR’s 
masking tools.
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ADDING LAYERS TO AN EXISTING DOCUMENT

When you’re working in the Edit module, you can add layers to a file by choosing Add Layer from File from 
either the Layer menu or the Layer pop-up menu. The Add File window will come up, letting you choose 
from the hundreds of built-in extras that ON1 ships with HDR, or from any file that is accessible on your 
computer and is supported by HDR (see “Working with Files” on page 5 for more). 

The default view for the Folders tab in this window is the location of the current document or image. You 
can navigate to any folder on your system via the Browse button in the upper right corner of the window: 
navigate to the folder you wish to browse, and click the Open button. The Add File window will now display 
the supported files. Just double-click on the one you wish to add. 

The Extras tab in the Add Layer window automatically displays two folders, My Extras and ON1  Extras, 
each subdivided into three sub-folders: Backgrounds, Borders, and Textures. ON1 HDR 2020 ships with 
more than 800 free images that you can add as a layer from the ON1 Extras folders. And, if you’ve added 
any of your own backgrounds, borders or textures to HDR via the Extras Manager (see ), these files will be 
visible via the My Extras folder.

NOTE: If the file you add is larger or smaller than the pixel dimensions of 
the document, use the Transform tool to resize it as desired. If you wish to 
preserve the original aspect ratio of the placed file, use the Shift key to resize it 
proportionally. 

USING THE TRANSFORM TOOL WITH LAYERS

Use the Transform tool at the top of the Toolbar to manipulate layers. A layer may be repositioned, sized 
or rotated using the tool. When selected, transform handles will appear on the edges of the selected layer. 
You use these transform handles to manipulate the image. You can only transform one layer at a time. 

When you choose Add Layer from File, a window appears with Extras and Folders tabs. The Extras tab contains backgrounds, textures 
(shown above) and borders supplied by ON1 with HDR, as well as any extras you might have added via the Extras Manager. Clicking on the 
Folders tab (or the Browse button at the top right of the window) will let you browse your computer for photos and other supported files.
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Repositioning a Layer 

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction. 

Resizing a Layer 

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center. 

You can type in the size you desire in the Tool Options bar in the width and height fields. You can also size a 
layer to fill the canvas automatically by pressing the Fill button in the Inspector. 

Rotating a Layer 

To rotate a layer, move the Transform tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use Option/ 
Alt with the left or right arrow keys to rotate a layer when the Transform tool is selected. To rotate the 
layer quickly in 90 degree increments, you can use the rotate left and rotate right buttons in the Tool 
Options bar. 

Flipping a Layer 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar. 

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options Bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options Bar or by pressing the Escape key. 

NOTE: For detailed specifics on how to use the Transform tool’s options, see 
page 21.

ALIGNING LAYERS

One of HDR’s most advanced features is the ability to align multiple layers based on content. This can be a 
great aid when you’ve hand-held a group of shots, and want to blend portions of one image onto another, 
to use a better sky, for example. 

To align layers, open them in the Layers pane, and choose Align Layers from the Layer menu or pop-
up menu. HDR will then analyze the contents of the layers, and aligns them to the one with the most 
commonality. When you look at the individual layers after aligning them, you’ll see that some layers have 
been moved or rotated slightly to match the content.
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An example of HDR’s layer alignment can be seen in the photos below, which are handheld shots taken two 
days apart from the same location. The top photo is the base layer, shown after alignment, but with the 
second layer hidden.

The bottom photo shows the aligned layers, with a gradient mask blending the top part of the base layer 
with the bottom part of the other photo.  Despite the fact that the photos were shot days apart, HDR has 
aligned the photos perfectly.

The base aligned layer. 

The final aligned photos, blended together with a gradient mask from top to bottom. 
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PART 5: OUTPUT AND SHARING
While editing and organizing your photos are probably the most important tasks you’ll do on a regular 
basis inside ON1 HDR 2020, there will be times when you want to “do something else” with your photos. 
Whether it’s enlarging photos for high-quality prints, sharing your photos with others or on social media, 
or printing to your desktop printer, HDR has all the functionality you’ll need to get your photos where you 
want them to be. 

In this section, you’ll find detailed information on the following topics:

• Export: The power of ON1’s patented Resize technology in an easy-to-use panel. Export your 
photos with flexibility and control.

• Print: Print your photos in any size, as individual photos, or in contact sheet form.

• Share: A quick way to share your photos (MacOS only).
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Export
Export is a special panel that is always available in 
ON1 HDR 2020. The Export pane gives you the 
power of ON1’s patented Resize technology in an 
easy to use panel, letting you export your photos 

with incredible flexibility, ease and control.

To open the panel, click the Export icon in the lower right corner 
of the module selector, or choose Export from the File menu. Once 
selected, the Export panel opens on the right side of the main HDR 
window, letting you select a group of options as you prepare to 
export a photo. By default, the panel includes two active panes, 
which are located at the bottom of the Export panel: File Type and 
Location. Adjusting these two options is required when exporting 
a file, but you can also expand your export options with the Photo 
Size, Watermark, Sharpening, Tiling, Gallery Wrap, and Rename 
panes.

FILE TYPE

The File Type lets you choose what format you want your photo to 
be exported as, along with a color profile that you wish to assign 
to the exported file. The type options are Photoshop, Photoshop 
Large Document, JPEG, TIFF, and PNG.

Saving as JPEG lets you choose a Quality setting, with 100 being 
the highest.

LOCATION

Click the Choose button to select a location, or click on the Save 
To pop-up for more options, including:

• Current Folder will write the file to the same location as 
the original file.

• Folder lets you choose a location by pressing the Choose 
button

• Round Trip (only available when exporting through 
Adobe Lightroom) saves the file tover the original and 
uses the same format, bit-depth, color space and name.

With regard to the other options in this pane, If Prevent Overwrite 
is selected the word ‘copy’ will be added to the file(s); otherwise 
it will overwrite your original image if the destination is set to 
Current Location. You can also have HDR open the folder you 
exported your image to by choosing the Show in Finder (MacOS) or 
Show in Explorer (Windows) option from the After Export menu.
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RENAME

This option may be used to rename the file name. The options 
include: Current Name, Text, Date and Number. The field to the 
right allows you to enter a custom name. The plus and minus 
icons will allow you to add or remove naming elements. Current 
Name will use the source name without the file extension. Text 
is used for assigning a custom text string. Date lets you add 
today’s date in any one of 12 standard formats. Number creates an automatically incremented number, 
starting with the number input in the field. Reset will clear all current settings.

PHOTO SIZE

The Photo Size pane displays the original image size when you 
first open it. You can simply type into the Width or Height fields 
to change the document size, or you can choose from a variety 
of preset sizes—including standard photo paper sizes—by clicking 
on the pop-up menu underneath the Resize To pop-up.

Keep in mind that the Width and Height fields are locked 
together to maintain the photos proportions. Changing the 
width will change the height proportionally. Export does not support non-proportional scaling. If you would 
like to change the proportions of the image it requires cropping.

The Long Edge and Short Edge options in the Photo Size pane are useful when you want to lock one edge 
to a specific length or width and don’t care about the sizing of the other edge. Simply choose which option 
is the important one for your photo, enter the dimensions, and Export will resize your photo accordingly.

NOTE: Export does not offer any options for cropping, and if you choose an 
aspect ratio that is different from that of your photo, on export, your photo will 
be cropped from the center point out to meet the new ratio. If you wish to crop 
to a different ratio, it is better to use Resize.

The units of measurement can be switched by clicking the down arrow. You also control your resolution in 
pixels per inch. Use this setting to optimize for your output device.

The Photo Size presets make it easy to set the width/height of your image in a preset size. Use the drop 
down menu to select a preset size or choose custom to create your own.

The Image Type drop down provides a few options for resizing:

• General (ON1 Resize) uses the ON1 Resize algorithm also known as Genuine Fractals: This is 
the classic, patented, fractal-based algorithm that has made Perfect Resize the standard for 
over a decade.

• Low-Res JPG is best for enlarging low resolution JPEGs (this setting use the bicubic algorithm 
method).

• Portrait works well for resizing portraits protects skin tones from artifacts (uses bicubic 
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algorithm method).

• Landscape is great for Landscape photos (uses ON1 Resize algorithm).

• High Detail is great for images with many small items (uses ON1 Resize algorithm).

WATERMARK

The Watermark module allows you to add an overlay to the 
image, most often used for your logo, signature or copyright. 
Watermarks generally need a transparent background, so make 
sure your watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting to 
social media—it needs to be the same size as what you are exporting for the web, typically over 1000 pixels. 
Using a watermark file that is too small will create a pixelated watermark appearance.

SHARPENING

The Sharpening pane adds additional sharpness to your image, 
and are designed to be general options for screen or print work. 
Using these controls can save you the workflow step of adding 
additional sharpening before printing and can help compensate 
for loss of sharpness due to dot gain from your printer. Sharpening should only be applied at the end of 
your workflow, just before printing. If you plan to do additional retouching or compositing work after 
resizing your image, you should disable the sharpening controls.
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TILING

The tiling feature in Export divides an enlargement into smaller 
pieces so that the image can be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet tall 
by 12 feet wide, but your printer can only print 24-inch wide 
strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create 
your mural in sections.

With the tiling feature all you do is specify the size of paper 
you have to print on and if you would like the pages to overlap. 
Then Export will resize your image and section it down into the 
individual tiles.

To use the Tiling pane, follow these instructions:

1.	 Set the Width/Height fields to the size and orientation 
of paper you wish to print on, or select the number of 
rows and columns instead.

2.	 Set the Overlap size. The overlap makes each tile 
overlap so you can tape multiple panels together and corrects for printer margins if you are 
not printing borderless.

The preview will show cyan guide lines for each tile that will be created.

GALLERY WRAP

The Gallery Wrap feature is designed to help you print on 
canvas. When making enlargements for canvas it is common 
to wrap a portion of the image around wooden stretcher bars. 
These are used for mounting the canvas. These are commonly 
called gallery wraps. However, if the photo has important detail 
near the edges of the image they may be lost in the wrapping 
process. The Gallery Wrap feature in ON1 Resize automatically 
creates extended margins by reflecting or stretching the areas 
near the edge of the image allowing the photographer to create 
a gallery wrap without having to sacrifice any of the original 
image. The Gallery Wrap feature allows you to select the 
thickness of the canvas mounting bars and offers a variety of 
techniques for creating additional margins.

To use the Gallery Wrap feature follow these instructions:

1.	 Set the Thickness control to the amount of margins 
you would like to add. A good rule of thumb is the 
thickness of the stretcher bars, plus half an inch.

2.	 Select the Type you would like to use.

3.	 If you wish to add an overlay to the wrap wings, set the color and opacity.
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The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap. The 
Type pop-up has four options:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 
to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can also darken the wrap or add a solid color to the wrap area with the Overlay Color add Opacity 
sliders.

EXPORT PRESETS

Presets remember all of the settings and details selected in the Export window pane. To save a group of 
settings as a preset, click the Save Preset button at the bottom of the panel. Give the preset a name, and it 
will appear in the Presets pop-up at the top of the Export panel.

NOTE: Unlike presets in other parts of ON1 HDR 2020, you can’t export or 
import presets from the Export panel.

EXPORTING OPTIONS

When your export settings have been set, you have two options for exporting, accessible via a pop-up in 
the Export button at the bottom of the pane:

• Export in the Background: If you wish to keep working inside ON1 
HDR during the export process, choose this option. It will take more 
time, since not all of the app’s processing power will be dedicated to 
the export operation.

• Export Now: Choose this if you wish the export process to happen 
more quickly. You won’t be able to work inside HDR until the exporting is done.

To get the options, press and hold your mouse button over the down arrow in the Export button at the 
bottom of the pane, then make your selection. If you just click the button without holding, the default is 
Export Now, although HDR will remember your last setting if you change it.
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Printing
While editing and stylizing your photos are probably the most important tasks you’ll do on a regular basis 
inside ON1 HDR 2020, there will be times when you want to print your photos or export them in different 
formats and sizes. Whether it’s creating high-quality prints, or sharing your photos with others, ON1 HDR 
has all the functionality you’ll need to get your photos where you want them to be. 

HDR 2020 has a flexible print engine that can print photos at any size. You can print photos individually; or 
multiple versions of a photo, package style, on a single piece of paper. You can even print when using HDR 
as a plug-in from Lightroom.

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo or photos being printed.

B.	 View Selector: Lets you view the photos being printed individually, in facing-page view, or in 
grid view. The icon on the far right turns soft proofing on and off.

C.	 Filmstrip: Shows all of the photos that have been selected for printing, with check marks to 
turn printing on or off. (The Filmstrip is not visible when a single image has been selected for 
printing.)

D.	Page view: Displays the number of pages being printed, and lets you move from page to page.

E.	 Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

F.	 Print Area pane: Contains options for fitting and selecting the print image size.
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G.	Watermark pane: For adding a watermark to printed photos.

H.	Sharpening: Options for sharpening during the print process.

I.	 Print/Cancel: Print One (current image), Print All, or Cancel.

NOTE: The print engine in HDR 2020 is based upon the engine inside ON1 
Photo RAW 2020, which has the capability to print multiple photos at a time. 
Because HDR can only edit a single photo at a time, some options, like contact 
sheets and some view settings, are not applicable in ON1 HDR.

The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that has 
between 240 and 360 ppi. (HDR will use its internal resampling 
engine to ensure that your photo is at the print resolution you 
choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. (You can use HDR’s Soft Proofing 
feature to look at out-of-gamut colors in your photos. See “Soft Proofing” on page 40 for more.)

NOTE: HDR’s Print feature will work with borderless printing options as well. 
Be sure to choose your printer’s borderless options in the page setup pop-up. 
Different printers will have specific borderless settings, so check the manual to 
see how to turn borderless printing on.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, 
click on the File icon at the top of the pane. HDR will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 
choose Print, HDR will create a PDF of the photo (or photos) and save it with the name and destination you 
specified earlier.

PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually or package-style. (The 
contact sheet option, while present, is not applicable in HDR, as it 
is largely designed to gang-print a set of different photos.)

The top of the pane includes preset styles for either fitting the 
current photo inside the size of the print, or filling the entire size 
of the print. It also includes options for printing at common print 
sizes, including 8x10, 5x7, 4x6; and options for printing to a contact 
sheet. You can also create custom print sizes via the Custom 
section at the bottom of the pane; just set the width and height of 
the print size, and whether you wish to fit the image to the print 
size, or to fill the frame with it. If you would like to save this print size as a style, click on the More pop-up 
at the top of the pane, and choose Save as New Style from the menu. You’ll then be able to recall that style 
from the More pop-up whenever you print.

If you are printing multiple copies of a single photo, HDR will attempt to put as many photos at your chosen 
print size on the paper size as defined in the Printer pane. To print only one photo per page, click that 
option at the bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Edit module. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need 
to play with the settings here; performing test prints on small 
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

Use the Sharpening pane to add additional 
sharpening to your printed image.
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Other Sharing Options (MacOS Only)
In addition to SmugMug publishing, the MacOS version of ON1 HDR 2020 includes other 
photo-sharing options, including:

• Mail: Creates a new email message in Apple Mail with the shared photo.

• AirDrop: Uses Apple’s AirDrop networking feature to share with local 
MacOS or iOS devices. 

• Notes: Adds the shared photo to Apple’s Notes app. You can choose to 
create a new note, or add the photo to an existing note.

• Messages: Shares photo to Apple’s Messages app.

• Add to Photos: Adds the photo to Apple’s Photos app.

All of the sharing options perform the same operation: HDR exports a full-size JPEG of the selected photo 
and shares it with the selected target from the list. 
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EDIT MENUS
ON1 HDR (MacOS Only)

• About ON1 HDR: Opens the About box and displays your 
version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)

• Quit ON1 HDR: Quits ON1 HDR 2020.

File Menu

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Export: Opens the export side panel.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Undo Delete: [unused]

• Redo Delete: [unused]

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the current 
location.

• Delete: [unused]

• Revert: Reverts to the original state of the current photo.

• Preferences (Windows): Opens the Preferences dialog.



ON1 HDR 2020 User Guide	 Part 9: HDR 2020 Reference	 89

Layer Menu

• Add Layer from File: Lets you add a new file to the current 
document as a layer.

• Delete: Deletes the currently selected layer.

• Duplicate: Duplicates the currently selected layer.

• Reset Layer Properties: Removes any applied layer masks or 
transforms to the current layer.

• Merge Layer: Merges the current layer with the one beneath 
it.

• Merge Visible: Merges all of the visible layers into a new, 
merged layer.

• New Stamped Layer: Merges the visible layers into a new, 
composite layer, leaving the visible layers intact.

• Align Visible Layers: Aligns visible layers based on their 
content.

Photo Menu

• Rotate 90 Degrees CW: Rotates an image clockwise by 90°

• Rotate 90 Degrees CCW: Rotates an image counterclockwise 
by 90°

Mask Menu

• Invert Mask: Inverts the mask, what was hidden is revealed 
and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer mask 
based off of a photo’s black or white tonal values.

• Show Mask: Displays the current mask either as a red overlay 
or as grayscale.

• View Mode: Sets the Show Mask mode to either red overlay 
or grayscale.
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Settings Menu

• Reset All Settings: Resets all of the Edit module settings on a 
photo.

• Reset Develop Settings: Resets settings applied in Develop.

• Reset Effects Settings: Resets settings applied in Effects.

• Reset All Retouching Tools: Resets retouching applied in Edit. 

• Reset Local Adjustments: Resets any local adjustments.

• Reset Crop: Resets any cropping made to a photo.

• Save Settings as Preset: Saves the editing settings of the 
selected photo as a preset.

• Update Preset with Current Settings: If an image with a 
preset has had some settings changed, this lets you update 
the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web page.
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View Menu

• Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Preset Browser: Sets the Preset panel browser view to 1, 2 or 
3 columns.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Show Focus Mask: Displays a green overlay on those portions 
of the current image that are in focus.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view of the 
current image, with the Before view on the left side of the 
preview area.

• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing for the current 
image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
choosing a profile will apply soft proofing for that profile’s 
paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, HDR will set the 
white point and black point of the display to account for that 
of the chosen profile.
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Window

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Navigator: Hides or shows the Navigator, Loupe, Histogram 
and Info pane.

• Layers: Collapses the Layers pane.

• Solo Mode: Keeps only one pane open at a time.

• Show Layers: Completely hides/shows the Layers pane.

• Open Quick View Browser: Opens the Quick View Browser 
overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the text labels in the 
module selector.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help

• Search: Searches the menu options (MacOS only).

• ON1 HDR 2020 Online Help: Opens ON1.com support page 
in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Getting Started: Opens the initial HDR startup screens.

• Check for Updates: Checks with the ON1 update server to 
see if you are running the current version. If there is a newer 
version, you will be notified and be walked through the 
update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 HDR 2020.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 HDR (Windows Only): Opens the about box with 
the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 HDR 2020.
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PREFERENCES
ON1 HDR 2020 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 HDR 2020 menu (MacOS) or the Edit menu in Windows.

The Preferences window has three tabs—General, Plug-Ins, System—and are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the HDR workspace, including background 
color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of the 
preview window. Scrolling up increases the zoom, scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the panning is 
comfortable, not too fast or slow or jerky.

• Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the HDR interface.

Application Language

Lets you change the display language for ON1 HDR 2020. Auto will use your system’s default language.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.
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PLUG-INS

The Plug-Ins tab is specific to using HDR as 
a plug-in Lightroom. This preference lets you 
choose the specific options for files opened via 
the Plug-In Extras menu in Lightroom:

• File Type: The file type drop-down 
menu determines what type of file will 
be created. The default is PSD, which 
maintains layers. You can also select JPG 
or TIFF if you prefer those formats and are 
not concerned about maintaining layers. 
The last option is same as source, which 
maintains the file type of the original file, except for Lightroom raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.

SYSTEM

The System tab sets performance-related 
characteristics of HDR 2020.

Memory Usage

• System Usage: Specifies the amount of 
RAM that is used by the application. The 
maximum (default value) is 80%.

• VRAM Usage: Specifies the amount of 
video memory (VRAM) that is used by the 
application. The maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running HDR. This is helpful if your system drive has limited space and wish to use a faster external drive as 
a cache. This cache information is purged each time you quit the application.
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Performance

The Performance section is designed to help you optimize HDR for your specific setup. The adjustments 
you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of brushes and 
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try 
turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.
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